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Welcome to NX

January 2019

Dear Customer:

We are proud to introduce the latest release of NX.

This release marks a major milestone in our industry as we move to a continuous release process. This
will make it easier for you to stay current with the latest release of NX, giving you convenient access to
new functionality, as well as performance and quality improvements. NX will automatically check for
updates, and you can control if and when you deploy those changes.

In addition, this major release brings significant new and enhanced functionality in all areas of the
product. It also delivers enhancements that enable you to increase your productivity in product
development and manufacturing while working in a collaborative managed environment.

Design

In the design environment, we have invested in enhancements to all aspects of modeling, including
both traditional modeling and our Convergent Modeling™ software, and to core functionality, such
as visualization and user interaction.

With the increased use of 3D annotation and model-based definition approaches to communicate
design intent, we are pleased to introduce new capabilities for comparing PMI that will make it
easier for you to track changes to the annotation defining your models. In addition, we are
introducing a new technical data package (TDP) solution that will make it easier for you to share
information with both customers and suppliers, improving collaboration and supplier exchange of
data.

We have enhanced our embedded virtual reality (VR) application introduced in NX 12.0.2 with new
tools to give you greater levels of interaction with your designs. Using our embedded VR tools, you
can bring the digital twin to life.

Manufacturing

New subtractive and additive manufacturing capabilities in NX will enable you to transform the way
you make parts. Enhanced CNC programming automation, new high-speed machining methods,
and advanced robotics to automate production are added to help you deliver higher quality parts
significantly faster. Improvements to additive manufacturing are also made to help you set up the
build tray and design critical support structures more easily, and with more control than ever before.

NX Release Notes  3

© 2019 Siemens Product Lifecycle Management Software, Inc.



Simcenter 3D

Simcenter 3D is a unified, scalable, open, and extensible environment for 3D simulation. In this
release of Simcenter 3D, we introduce new, cutting-edge simulation capabilities, stronger
connections to the broader Simcenter portfolio, and an expansion of the integrated multidisciplinary
environment to cover an extended simulation solution footprint. Highlights include new and
enhanced simulation solutions for generative design and the simulation of the additive
manufacturing process—making Simcenter 3D capable of simulating tomorrow's engineering and
manufacturing processes today. Additionally, Simcenter 3D’s simulation footprint has been extended
to cover new solutions like transmission simulation, which can reduce overall transmission
simulation process time by 80%. This release also includes new ties to the digital thread through
synergies between Simcenter 3D and the broader Simcenter portfolio, such as STAR-CCM+, for aero-
acoustic and aero-vibro-acoustics analysis. With added enhancements that build on the new
Convergent Modeling™ capabilities in NX, you'll also be able to perform direct meshing of
convergent bodies to streamline the process of analyzing scanned or optimized data. Overall,
Simcenter 3D helps engineers drive innovation and reduces the effort, cost, and time needed to
predict product performance.

We are confident that this release of NX empowers you to work more productively than ever before, and
that it will help you get more from your investment by making it easier to adopt and deploy the latest
functionality and improvements to stay at the forefront of industry trends.

For more information about this release, see the What's New Guide included with the NX help.

Sincerely,

Your NX team
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1. System Information
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Customer support

Customers covered by valid maintenance agreements are eligible to receive telephone and web support
from the Global Technical Access Center (GTAC) on issues regarding any current or past release. If you
are a customer of one of our partners or resellers, you should contact them first to determine who is
your first line support provider. If your first line of support is provided by one of our partners, they will
contact us on your behalf if needed to respond to your issue.

To report serious problems against supported releases, please contact your local GTAC support center.
You can find your local support center, contact phone numbers and additional information on GTAC
support and available services by visiting our GTAC page at http://www.siemens.com/gtac

We will always assist our customers to the best of our ability.

Customer support
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Platforms

Customer support
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NX central runtime directory

Central runtime directory concept

Starting in NX 11, to help you find executables and libraries, and distinguish them from configuration
files more easily, a central runtime directory that contains DLLs (or so's, or dylib's), executables, and JAR
files is used. The central runtime directory will be updated as NX supports more and different
applications.

Scripts that are used to wrap executables have not been moved and they are still in their original kit
locations with the configuration files.

NXBIN directory

The central runtime directory, NXBIN, is created on all platforms at the UGII_BASE_DIR\nxbin location
during the NX installation. Depending on what was selected to be installed, libraries and executables
from different kits are consolidated into the central runtime directory during the install process.

The new NX runtime directory does not contain all binaries and executables. Only the most frequently
used files from the following directories have been moved:

• UGII

• UGMANAGER

• STEP203UG

• STEP214UG

• PVTRANS

• MACH

Other files will also be moved over time. However, some applications, such as NX Nastran, will not be
moved.

While NXBIN does not contain all of the executables and DLL's, it does contain a large quantity and is a
prime location to search for an executable or library.

NX central runtime directory
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UGII_ROOT_DIR obsoleted

UGII_ROOT_DIR has historically been used to find the following in the UGII directory:

• Libraries and executables

• Configuration files

With the creation of the central runtime directory, there are two different locations for these files (nxbin
and ugii), so the concept of UGII_ROOT_DIR is obsoleted. Use the UGII_BASE_DIR variable instead when
you write custom application code and scripts.

While the NX install no longer sets UGII_ROOT_DIR, the definition on the system will remain to support
earlier releases. If your code or scripts rely on UGII_ROOT_DIR, modify them to ensure they work in NX
1847.

Teamcenter code and scripts

To provide backward compatibility with released versions of Teamcenter, all executables called directly
by Teamcenter code or scripts are wrapped.

The wrapper executables just correct the settings of the UGII_BASE_DIR, PATH, and LD_LIBRARY_PATH
variables that are set by the Teamcenter scripts and code, and then start up the real executable from the
NXBIN directory. This enables support for the new runtime concept, while allowing NX to run with
existing versions of Teamcenter.

These new wrapper executables must remain in the ugii and ugmanager directories since that is where
Teamcenter code expects to find them. Two processes are shown for executables invoked from the ugii
and ugmanager directories.

Executables are still in the UGII, UGMANAGER, STEP203UG, STEP214UG, and PVTRANS kits.

Teamcenter code migration to the new central runtime directory structure is scheduled in a future
Teamcenter release.

NX central runtime directory
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System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably
memory, can vary dramatically from user to user. The following are general guidelines that you should
consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute
to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory
speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the
performance is," but this only applies when comparing like architectures. For example, it is difficult to
arrive at performance expectations for an Intel processor when compared to an AMD processor just by
looking at their respective processor speeds. There is also a general trend today to de-emphasize
processor speeds and move to multi-core processors, which actually can have lower processor speeds.

NX takes advantage of modern processors, and if a processor does not have the required functionality,
you will see the following error message and NX will not run on the installed CPU:

This processor is too old and not supported anymore

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of
NX capabilities have some threading. In general, it is not possible to quote a figure for the general
performance improvement achieved by using SMP, since this improvement depends on the nature of the
operations you are performing. You need to evaluate your actual performance gains using your own
models. Functional areas that are SMP enabled in Parasolid include:

• Validity checking

• Boolean operations

• Wireframe

• Rendering

• Hidden line rendering

• Closest approach

System requirements guidelines
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• Faceting

• Mass properties

SMP is enabled by default with the variable UGII_SMP_ENABLE, which is located in the ugii_env_ug.dat
file.

Multi-Core

Multi-core processors are similar to SMP because there are two or more actual processor cores but they
are delivered in single processor packages.  Siemens PLM Software has found that multi-core
performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is
that this technology has proliferated much faster than SMP and is now common in workstations,
servers, and laptops.

Multi-core technology is complex and, depending on the configuration, can actually have a negative
impact on performance. This is due to the potential conflict of multiple cores sharing system resources,
such as cache, memory, and bus bandwidth, as well the need for the system to manage and control an
increasing number of cores. Increasing the number of cores does not always translate into better
performance. Although additional cores can improve NX performance, processor speed is still a vital
measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare performance
with a different number of cores that are active. Some users may find that turning off some cores will
actually improve performance. One micro-architecture (Intel) even does this automatically, shutting
down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the
limitations of older multi-core technologies. New subsystems better integrate memory and other
peripherals directly to the processors, resulting in major performance improvements. Buses are being
eliminated, cores are better managed, and channel speeds continue to improve.

In summary:

• Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a
slight overhead.

• Turn SMP on if you have a multi-core system.

• Never assume that by simply adding more cores you will see better performance. Always test first.

System requirements guidelines
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Memory

The minimum recommended amount of memory to run native NX is 8GB. If you are running NX with
Teamcenter (Teamcenter Integration for NX), the minimum recommended is 12 GB. However, because
NX is capable of handling large assemblies and very complex parts, many of our customers use
workstations with 32GB of RAM, and some even use 64GB, 96GB, or more.

For the optimum user experience and application performance, we recommend that you install as much
RAM as can be installed in the client workstation that is running NX.

As a guideline, so that you get the best possible performance when using NX, ensure that the amount of
physical memory (RAM) in your workstations is always larger than the amount of memory consumed by
NX, plus all the other applications that are running at the same time on the same machine. This can be
done by using a tool such as Windows Task Manager or Resource Monitor.

The minimum memory requirements varies and depends on various factors including:

• Complexity of the geometry within individual parts

• Size of the assemblies that are loaded

o Less memory is required if the assemblies contain multiple instances of the same
components.

o More memory is required when large assemblies contain lots of unique components with
complex geometry.

• Use of Teamcenter in addition to NX

o Some additional memory is required when using Teamcenter 4-tier.

o A even greater amount of memory is required when using Teamcenter 2-tier.

• Fully loading exact assemblies versus using lightweight assemblies and partial loading

• Generating CAM toolpaths for very complex geometry, such as an automotive engine block or
gearbox

• Updating large assembly drawings

System requirements guidelines
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Graphics adapters

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements
and are fully supported by our hardware partners. The graphics adapters supported are carefully
selected by working with our OEM partners as well as our graphics vendor partners. We do not
recommend low-end, consumer, or game cards, since these graphics devices are developed for the
DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware
problems are graphics related, it is critical that all the graphics adapters that NX supports are designed
for OpenGL and have the highest level of support from our hardware vendors. We highly recommend
that you only use supported graphics adapters and Siemens PLM Software certified drivers.

For the latest information on certified graphics cards and driver versions, please visit the Customer
Support (GTAC) Web site.

Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary
due to the large number of possible configurations. Other combinations may work, but these conditions
are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in
the future.

The following is a summary of findings for the support of multiple monitors.

• NX 6.0.1 or higher - no older releases are supported.

• Two monitors only.

• LCD monitors only

• Run with native resolution and aspect ratio.

• Laptops are tested without docking stations or port replicators (direct connection only).

• Horizontal Scan mode (not Vertical) and only with identical monitors.

• Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window
entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to
duplicate the problem on the configurations in our labs before being able to investigate your issues.

System requirements guidelines
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Operating system requirements

Operating system requirements

This section documents operating system and service pack requirements.

Minimum Operating Systems

The following operating systems are the minimum recommended for NX. Newer versions and service
packs are available as they are released.

O.S. Version
Microsoft Windows (64-bit) Microsoft Windows 10 Pro and Enterprise editions
Linux (64-bit) SuSE Linux Enterprise Server/Desktop 12

Red Hat Enterprise Linux Server/Desktop 7

Linux

Starting in NX 1847, NX is no longer supported on the Linux operating system for interactive NX (NX
running with UI), which includes graphics and XESS integration. It is only supported for running solvers
and NX Open batch programs with no user interface calls.

Contact GTAC for the new NX Linux product.

Mac OS X

Starting in NX 1847, the Mac OS X operating system is no longer supported.

Windows 10

Windows 10 is the minimum supported release for NX 1847. The supported versions of Windows 10 are
the Professional and Enterprise editions utilizing either the Current Branch for Business (CBB) or Long
Term Service Branch (LTSB) update branch. The Current Branch (CB) update option is not supported.

Windows 10 is also available for NX 10.0.3 and later versions including NX 1847. Any caveats or special
instructions are provided in the SFB announcing support.

Windows 7 and 8.1

Windows 7 has reached the end of life and mainstream support has ended. Windows 8.1 is still
supported by Microsoft, but was rarely deployed. These two versions of Windows are no longer

Operating system requirements
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supported by NX 1847. Siemens PLM Software has not performed testing on these versions and cannot
resolve any issues related to NX 1847 running on these operating systems. If NX 1847 is deployed on
these versions of Windows, any issues will have to be replicated on Windows 10 before filing an incident
report with GTAC.

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of
Windows are not supported by NX 1847. Siemens PLM Software has not performed testing on these
versions and cannot resolve any issues related to NX 1847 running on these operating systems. If NX
1847 is deployed on these versions of Windows, any issues will have to be replicated on Windows 10
before filing an incident report with GTAC.

System error when running NX

If you receive the following system error when launching NX, the problem is generally that the
operating system is not up-to-date for the required and optional updates. This error can occur with
Windows 7 and Windows 8.1.

The program can't start because api-ms-win-crt-heap-l1-1-0.dll is 
missing from your computer.

The error occurs when there are missing Visual C++ libraries due to a dependency on the Universal CRT
libraries in Visual C++ 2015. To fix the problem, install the Visual C++ 2015 update 3 redistributable
from Microsoft. The 64-bit redistributable (vc_redist.x64.exe) is available in the INSTALL folder of the NX
runtime environment after installation, or you can download the redistributable from Microsoft.

If you still have a problem, contact GTAC support.

Linux Distributions

NX is developed using Linux standards and accepted Linux development conventions. Quality assurance
testing is performed on the two versions of Linux listed in the table above. Siemens PLM Software
cannot guarantee operation, performance, compatibility, or support on any other distributions.

The following is a list of information about the NX 1847 development environment (for reference only):

Kernel kernel3.10.0-123.eI7.x86_64
C, C++ Compiler gcc 4.8.2
Java Development version 1.8.0_45

Considerations and caveats

Considerations and caveats
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Linux Requirements

NX supports SuSE Linux and Red Hat Linux, both 64-bit only. The minimum supported version of SuSE
Enterprise (Desktop/Server) is 12 and Red Hat Enterprise (Desktop/Server) is 7.0. Newer versions will be
supported via certification.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well
as for the latest graphics drivers.

Java Runtime Environment

The Java Runtime Environment (JRE) is not shipped with NX, but NX does require JRE 8 for certain
products. To install the JRE, visit the Java download site at http://java.com/en/download/index.jsp

Java is used for the following products:

• NX Relations Browser

• Manufacturing – Process Studio Author

• Command line version of the following translators:

o CATIA V4

o CATIA V5

o Dxfdwg

o IGES

o NX Pro E

o Step AP203

o Step AP214

• Knowledge Fusion ICE

• Quality Dashboard

• Validation Rule Editor

Considerations and caveats
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• Simcenter 3D Batch Mesher

• Simcenter 3D Response Analysis Function Tools

• Simcenter 3D Report Writer

• Customer written NX Open Java programs

Java requirements for NX Open

NX Open for Java is designed to be used with Java version 1.8.0_45 or higher.

Post Processing of Abaqus ODB format results

In the NX release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these
libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.

Note:
If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should
already be installed.

You can download this runtime from the Simulia customer support website: http://www.3ds.com/
products-services/simulia/support/

For more information on the system requirements for ODB version 6.12 files, see: http://www.3ds.com/
support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-
abaqus-612-products

Running Samcef in parallel

On Windows, when you run parallel computations with the built-in Samcef solver, Python 2.7 is
required. In NX 1847, that version of Python is not present. Install Python 2.7 on your disk and ensure
that the Python directory is named Python27 (default name) and is included on your PATH variable.

You can download the software from the Python website: https://www.python.org/downloads/

Note:
The Python requirement does not apply if you have Samcef installed separately from NX.

Considerations and caveats
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Configuration files

Starting with NX 12, the NX configuration files on Windows are written to C:\users\<name>
\AppData\Local\Siemens.

Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework
component. Before you can execute a custom .NET application, you must install the .NET Framework
4.6.2. In addition, to replay a .NET journal, the .NET Framework 4.6.2 must be installed.

To download the .NET Framework 4.6.2, use the links on this page: Microsoft .NET Framework 4.6
(Web Installer).

Considerations and caveats
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Supported hardware and graphics

The list of currently supported hardware and graphics cards can be found on the GTAC support page
Customer Support (GTAC) Web site at Hardware and Software Certification→Hardware (Graphics
Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.

Supported hardware and graphics

NX Release Notes  1-15

© 2019 Siemens Product Lifecycle Management Software, Inc.

http://support.ugs.com


NX Open programs on Linux

If you try to link an external NX Open C++ program using the ufmenu and uflink scripts with NX 1847
on SLES 12, Linux may fail with an error message such as:

/usr/x86_64-suse-linux/bin/ld: cannot find -lelf

For NX to properly build an NX Open program, you must have the correct RPM kits installed.

For NX 1847 and SUSE 12, the following packages are required:

elfutils-0.158-3.200.x86_64.rpm
libelf1-0.158-3.200.x86_64.rpm
libelf-devel-0.158-3.200.x86_64.rpm

For NX 1847 and RedHat 7, the following packages are required:

elfutils-libelf-0.158-3.el7.x86_64.rpm
elfutils-libelf-devel-0.158-3.el7.x86_64.rpm
elfutils-devel-0.158-3.el7.x86_64.rpm
elfutils-libelf-0.158-3.el7.x86_64.rpm
elfutils-libs-0.158-3.el7.x86_64.rpm

Note:
For SUSE, the devel packages are available from the optional SLE 12 SDK DVD/ISO.

NX Open programs on Linux
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Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root
cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory
Java is able to report back an error code indicating this problem. However, in some cases Java reports a
generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an
unexpected error due to this problem.

Starting in NX 8, if NX detects that there is not enough memory available for the JVM, an error message
is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block
available is outputted below.
Windows largest block free 
=================================
 Maximum block 267Mb
=================================
Please note, this number is to be used as suggestion for setting the 
heap size. It
is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use 
the /3GB
switch or its equivalent, if available for the Operating System you are 
on.
Otherwise your other option is to use Remoting. Please consult the NX 
Open
Programmer's Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose
File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the
size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already
started then you cannot change the UGII_JVM_OPTIONS setting.

Initializing the JVM
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It is recommended that you use both the –Xmx and –Xms options together. Both of these are needed as
Java may determine default values for the heap size that are not possible with the machine’s current
memory load. For example:

UGII_JVM_OPTIONS=–Xmx=50M –Xms=50M

When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java
program you are trying to run may not run. This could be due to the amount of memory available on the
machine, or due to multiple Java processes running. This can be the case with the Wave Browser where
there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the ugii_env.dat file
so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX
session.

Initializing the JVM
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NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env_ug.dat file contains the standard environment variables for NX. You can override these
variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new
values for the environment variables in this file and they take precedence over the values defined in the
ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>\ugii.

Note:
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file.
However, it is recommended that you use the ugii_env.dat file to define all of the values in use at
your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

• Define the variables before the #include statement.

• The first variable defined is used. If you have the variable defined twice in the file, only the first one
is used.

Note:
This also applies to the ugii_env_ug.dat file.

• You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

UGII_ENV_FILE=G:\common\version_env_vars.corp_standards

NX variables in the ugii_env.dat file
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Note:
The file can have any name but must be a fully qualified path.

Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

•
#if/#else/#endif

Used to check for specific conditions and then to define variables based on those conditions.
Conditions that can be checked are:

o FILE - Check for the existence of a file

#if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_$
{UGII_LANG}.html
#else
UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files
\start_english.html
#endif

o platform - Check for a specific platform. Possible values:

x64wnt

lnx64

macosx

#if lnx64
UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}thrm.so
#endif

o $variable = “value” - Check for a specific value for a previously defined environment variable

#if $UGII_LANG = "simpl_chinese"
UGII_COUNTRY=prc
UGII_COUNTRY_TEMPLATES=$UGII_BASE_DIR\localization\$UGII_COUNTRY
\simpl_chinese
#endif

NX variables in the ugii_env.dat file
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o $variable != “value” - Check for a previously defined environment variable that does not have
the specified value.

#if ${UGII_PACKAGE_DIRECTORY} != ""
#if FILE $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat
#include $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat
#endif
#endif

• #include

Used to include a specified environment file at the current location

#include $UGII_PACKAGE_DIRECTORY\ugii_package_env.dat

Enabling context sensitive help in local languages for customer defaults and KF

When using localized language versions of the NX Help, to get context sensitive help to work for
Customer Defaults or Knowledge Fusion you need to edit the following two environment variables to
point to the localized help:

• UGII_CSHELP_DEFAULTS_DOCS

• UGII_CSHELP_FUSION_DOCS

For example, to enable context sensitive help for Japanese Customer Defaults help you would set:

UGII_CSHELP_DEFAULTS_DOCS=${UGII_UGDOC_BASE}/data_services/resources/nx/$
{UGII_MAJOR_VERSION}/nx_help/ja_JP/graphics/fileLibrary/nx/cust_defaults
  

NX variables in the ugii_env.dat file
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Browser requirements
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Browser and plug-in requirements

The NX suite of documentation (Help, What's new Guide, and Release Notes) is provided in an HTML
format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server,
which sets up a local web server on each workstation, or install the documentation into an existing
company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security
updates.

Windows browser support

• Internet Explorer

• Microsoft Edge

• Mozilla Firefox

• Google Chrome

Downloading browsers

These browsers are free and can be downloaded from the following Web sites:

Internet Explorer — http://www.microsoft.com

Firefox — http://www.mozilla.org

Safari — http://www.apple.com

Windows .chm files

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security
enhancements prohibit opening .chm Help files across a network, so you must install those files on your
computer. If you install .chm Help files on a server, you cannot read the Help across the network.

Adobe Flash Player required for videos

To watch videos and simulations, you must have the Adobe Flash Player installed as a plug-in to your
browser. You can download the Flash Player (free) at the Adobe Flash Player site.

Browser and plug-in requirements
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Adobe Acrobat Reader

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can
download the free reader from http://get.adobe.com/reader/.

Browser and plug-in requirements
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Browser caveats

Browser caveats for Firefox

• Mozilla recommends that you upgrade to the latest version of Firefox due to security issues
surrounding Java. They do not recommend using older versions of Firefox. For more information,
see http://support.mozilla.org/en-US/kb/latest-firefox-issues.

• The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the
behavior of the global search since new links will open in a tab instead of a new window. You can
configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.

• Typically, you install and launch the Help from the http:// protocol which is fully supported.
However, if you want to launch from a UNC path (file:///), Firefox has a default security setting that
prevents the Help from launching correctly. To enable this, you need to change the value of the
security.fileuri.strict_origin_policy preference:

1. In the address bar, type about:config.

2. In the Filter field, type security.fileuri. If the value of the
security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-
click on the value to toggle it.

3. Restart the browser.

• If you are trying to open a .chm file that you have accessed from a web server (not from a local
install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and
choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if
you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://
code.google.com/p/chromium/issues/detail?id=39767.

Browser caveats for Adobe Flash Player

The following is applicable for the Adobe Flash Player:

• Chrome blocks Flash.

Browser caveats

NX Release Notes  1-25

© 2019 Siemens Product Lifecycle Management Software, Inc.

http://support.mozilla.org/en-US/kb/latest-firefox-issues
http://code.google.com/p/chromium/issues/detail?id=39767
http://code.google.com/p/chromium/issues/detail?id=39767


• Firefox blocks Flash by default. However, you can manually enable the Flash plugin for the
Windows 64 bit browser.

• Internet Explorer blocks Flash by default. However, you can manually enable the plugin.

• Microsoft Edge blocks Flash.

Browser caveats
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Licensing Caveats
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General licensing caveats

License files and license server

The following are applicable to license files and the license server:

• Merging of license files is not supported.

Example:
You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the uglmd license
daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the ugslmd daemon.

NX requires and tests for the latest version of the ugslmd vendor daemon. This vendor daemon is
supplied with NX and must be installed and initiated prior to starting NX. If an older daemon is
utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog
will contain an error message that the daemon version is older than the client.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software
used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always
utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX
1847 borrowing tool will work for NX 1847 but cannot be used to run NX 12. In addition, you cannot
borrow licenses for two NX versions simultaneously on the same workstation.

General licensing caveats

1-28  NX Release Notes

© 2019 Siemens Product Lifecycle Management Software, Inc.



Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The License Option tool should only be used to borrow NX licenses, even though it may display other
licenses. The License Option tool does not filter features in the license file that are of an earlier version
than NX, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool.
Attempting to borrow a license other than NX causes an error in the License Option tool.

Licensing caveats for Windows
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Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

• LSB 4.0

Licensing caveats for Linux
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Product compatibility - supported version combinations

Teamcenter and NX

The following table lists the version combinations of Teamcenter and NX that are supported.

(1) Teamcenter UA 10.1.2.2 or higher.

(2) NX 10.0.3: For Teamcenter UA 11.2.0 through 11.2.1, NX 10.0.3 or higher. For Teamcenter UA
11.2.2 and higher, NX 10.0.3 MP 10 or higher.

(3) NX 10.0.3 MP10 or higher.

(4) Teamcenter UA 10.1.5 or higher.

(5) For Teamcenter UA 11.2.2, NX 11 or higher. For Teamcenter UA 11.2.3, NX 11.0.0 MP3 or higher.

(6) NX 11.0.0 MP3 or higher.

(7) For Teamcenter UA 11.6.0.1, NX 11.0.2 or higher.

(8) Teamcenter UA 10.1.7 or higher.

Product compatibility - supported version combinations
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(9) Teamcenter UA 11.3.0.1_a01_1 or higher

(10) For NX 12.0.1, Teamcenter UA 11.3.0.1_a01_1. For NX 12.0.2 or higher, Teamcenter UA
11.3.0.1_a01_patch_5.

(11) For NX 12.0.2, Teamcenter UA 11.4.0_patch_5 or higher.

(12) For Teamcenter UA 11.6:Teamcenter UA 11.6.0.1 or higher, NX 12.0.2 MP5 or higher.

(13) NX 12.0.2 or higher.

(14) For Teamcenter UA 12.1: Teamcenter UA 12.1.0.1 or higher, NX 12.0.2 MP5 or higher,

(15) Teamcenter UA 11.4.0_patch_5 or higher.

(16) Planned compatible with NX 1851.

Note:
For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization,
see the Teamcenter documentation.

NX and Active Workspace with Teamcenter

The following table lists the version combinations of NX and Active Workspace that are supported. The
Teamcenter versions listed in each table cell are the minimum versions applicable for both the Active
Workspace version and NX version.

Product compatibility - supported version combinations
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NX compatibility with Spreadsheet
NX version▼ Platform► Windows
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Note:

• The 64-bit versions of Microsoft Excel are supported starting in NX 12. The 32-bit version of
Excel is installed by default on the Windows 64-bit Operating Systems.

• Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's,
Math and Equation Editing.

• If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates
the data to Excel 2007 or later (to the Excel version currently running with NX).

• If you launch a spreadsheet command such as Spreadsheet or Part Family on a system
having Excel 2003 or older version as the default spreadsheet application, NX displays an
error message and does not proceed with the launched command.

NX compatibility with Spreadsheet
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NX support for the currently supported versions of Microsoft Office will be discontinued as per the
following dates:

Microsoft Office version End of support

2007 October 11, 2017

2010 October 13, 2020

2013 April 11, 2023

2016 October 14, 2025

NX compatibility with Spreadsheet
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NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

Application Functionality Platform not
supported on:

Tooling & Fixture Design NX EasyFill Analysis - Advanced Linux
NX Translators & Open Tools NX Open Python Author Linux
Electro-Mechanical Design Mechatronics Concept Designer Linux
Mechanical Design NX Drafting Linux
Mechanical Design NX Additive Design with Convergent Linux
Mechanical Design NX Layout Linux

NX Translators & Open Tools Content Migration Manager for SolidWorks Linux
NX Translators & Open Tools CMM Drawing Repair Assistant Linux
Electro-Mechanical Design ELMA Linux
Electro-Mechanical Design NX Piping Fabrication Drawings & PMI Linux
Mechanical Design NX Lattice Structures Design Linux
Mechancial Design NX Ship Structure PMI Creation Linux
Mechanical Design NX Ship Dimensions & Adv Annotation Linux
Mechanical Design Drawing Automation for NX (version 10

and later)
Linux

Mechanical Design Layout for NX Linux
Mechanical Design NX Aerospace Design Linux
Mechanical Design NX Lattice Structures Design Linux
Gateway Advanced Studio Rendering Style Mode Linux
Pre/Post Abaqus OBD result file reading Linux
Pre/Post Topology Optimization and Shape

Optimization
Linux Redhat

Motion Motion Mechatronics co-simulation Linux

NX applications unsupported on specific platforms
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Support for touch enabled devices

In NX 1847, you can interact and manipulate 3D models and control the overall user interface using
touch screen and stylus. The support for touch enabled hardware follows a slightly different support
model than what is provided through the NX certification program. We have tested NX on a number of
Windows based touch screen laptops, monitors, and tablets. However, support for these devices and
other comparable systems is limited as they are not true workstations and do not qualify for our full
certification program. Support for these devices is limited as follows:

• Graphics performance issues are not supported as most of these devices do not offer the level of
driver support available on workstations.

• Graphics quality and display issues are not supported unless they can be duplicated on a certified
workstation.

• Any issue determined to be caused by the graphics driver is not supported.

• Performance issues with NX are not supported on these systems unless reproducible on certified
workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell,
Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

• NX supports touch devices on the Windows operating system.

• Only stylus configurations support pre-highlighting. The most commonly used devices supporting
stylus are the Surface Pros.

Support for touch enabled devices
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Product Notes

Running SSO

If you are using Teamcenter 11.3.0.1_a01_1 or higher, to run applet-free single sign on (SSO) with NX
12.0.1 or higher, you must install a session agent from the Teamcenter 11.4 kit.

Using ECNs for change management

To enable ECN change management, the NX1TCINCM Teamcenter template must be installed.

Note:
This template must be installed if you are running 4GD.

Teamcenter 11.5 supports global change context (GCC) where an ECN can be set as a GCC and all of the
newly created item revisions are automatically tracked as solutions of the ECN. NX 12.0.x does not
support this, so if you are using ECNs for change management and running Teamcenter 11.5 and NX
12.0.x, you need to set the following Teamcenter preference:

CM_enable_global_context = false

Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for
very specific data conditions and was never intended to be run by all customers on all of their data. This
utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release
make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile
utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX
12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up
related options and future NX batch processes.

Teamcenter names and values of properties localized

In Teamcenter, there is now the capability to have the names and values of properties translated and
displayed in multiple languages. You can see this functionality in some areas of NX (not all areas of NX
incorporate this functionality), such as the Part Family template spreadsheet, and New Item, Save, Save

Product Notes
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As, Import, and component properties dialog boxes. This is applicable for Teamcenter properties such
as: property names, property values, list of values, and BMIDE elements (type names).

Note:
This functionality is applicable for Teamcenter 11.2 or higher.

When you run NX, the language set by the environment variable UGII_LANG determines the language
that is used to display the names and values of TC properties in NX.

If you do not have translated values defined in TC for the properties, or you do not want NX to display
the translated values, set the following environment variable:

UGII_NO_TC_LOCALIZATION=1

When this environment variable is set, the property values shown in NX are always the internal value
(non-translated) and there is no indication in NX that the value has a translated value defined in
Teamcenter. This is the same behavior that NX had prior to NX 10. However, the environment variable
does not change the way the property names are displayed. If the property name has a translated value
that matches the UGII_LANG setting, the translated (localized) name is still shown in NX.

Product Notes
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Caveats

Starting NX in four-tier Teamcenter environment with WebLogic 10 MP2

When you are running Teamcenter in the four-tier environment with WebLogic 10 MP2, NX may not
start with no error messages displayed. This could be due to problems with the WebLogic server.

Note:
This is applicable only when you are using the WebLogic 10 MP2 Application Server.

Perform the following steps to modify the Weblogic XML file:

1. Stop the WebLogic application and locate the tc.war file in the WebLogic domain (typically in the
autodeploy directory).

2. Open the tc.war file using Winzip and extract the weblogic.xml file to a temporary location.

3. Open the weblogic.xml file using an editor (XML or text editor) and add a cookie-http-only XML
element with the value of false in the session-descriptor element. For example:

<session-descriptor>
   ...
   <cookie-http-only>false</cookie-http-only>
</session-descriptor>

4. In Winzip, delete the old weblogic.xml file.

5. Add the modified weblogic.xml file in your temporary directory into Winzip. To do this, drag the
web-inf folder that contains the weblogic.xml file and drop it into Winzip. Ensure the path of the
weblogic.xml file is web-inf\.

6. Restart the WebLogic application.

Creating an Alt Rep assembly using File New

You cannot have an assembly that is an alternate representation (Alt Rep) that has children that are not
also Alt Reps. The part types of the parts (Alt Rep) must match the part type of the assembly (Alt Rep).

However, when you choose File→New to create a new assembly and use the Blank template, NX lets
you create an Alt Rep assembly with children that are not also Alt Reps. This causes problems when you
use the assembly in NX.

Caveats
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Translators only supported in Teamcenter two-tier environment

Teamcenter only supports the installation of the following NX translators in a Teamcenter two-tier
environment, the Teamcenter four-tier environment is not supported:

• NXClone

• NXtoPVDirect

VLA Attribute Affix options modified

The VLA Attribute Affix customer default (Teamcenter Integration for NX→User Attributes, All tab)
is modified. The new options [Numeric] and :Numeric introduced in NX 8 caused problems when there
are references to VLA (variable length array) attributes in parts created prior to NX 8. The [Numeric]
and :Numeric options are now set to _Numeric when selected. You should use _Numeric if you are
setting this option for the first time.

Caveats
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3. Fundamentals
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Product Notes

NX Virtual Reality display environment

The NX VR environment operates within the following display framework:

• The color of geometry comes from the NX component or object color (Edit Object
Display→General tab, Basic group→Color). Color does not come from the True Shading material,
Studio material, face, or facet color.

• Only solid-body, facet-body, and sheet geometry is displayed in the VR environment.

• The VR environment does not support translucency in the display.

• Geometry tessellation quality follows NX graphics window tessellation quality.

The following NVIDIA VR system is supported for NX Virtual Reality:

• Virtual Reality Systems, Components, Drivers | NVIDIA Quadro – https://www.nvidia.com/en-us/
design-visualization/solutions/vr-ready-systems/

Refile utility to be retired

Historically, the NX product release has included the refile utility, which was created many years ago for
very specific data conditions and was never intended to be run by all customers on all of their data. This
utility was never mandatory when performing NX upgrades.

NX product enhancements and improvements that are delivered and available in the current NX release
make NX upgrades much faster and easier, so the refile utility is now obsolete. As a result, the refile
utility is retired starting in NX 12.0.1. The documentation for the utility has already been removed in NX
12.

In place of the refile utility, standalone utilities will be introduced that incorporate non-version-up
related options and future NX batch processes.

Issue management using Teamcenter Community

Management of issues using Teamcenter Community is discontinued in the NX 12.0.2 release and later
releases. You can manage your issues in Teamcenter.
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Unit Manager settings

When you run the ug_convert_part tool to convert an NX 12 part from mm to inch, the settings in the
Unit Manager dialog box do not display the converted units. This is as intended.

The Units Manager dialog box displays the units that you have selected as the default units for data
entry and object information output. Those units are independent of the underlying part units (metric or
inch).

Ray Traced Studio

To maximize rendering performance for NX, you need an NVIDIA GPU with CUDA Compute Capability 2.0
and higher, and a graphics driver supporting CUDA 8.0 or higher (For NVIDIA driver version, contact
GTAC).

Note:
Users upgrading to NX may need to upgrade to a later NVIDIA graphics driver version for CUDA 8.0
support.
Because some driver versions supporting CUDA 8.0 have incorrect documentation stating they
only support CUDA 7.5, the NVIDIA Control Panel should be checked to verify the actual CUDA
version supported.
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Tip:
The current CUDA version supported by the NVIDIA graphics driver can be obtained using the
NVIDIA Control Panel→System Information→Components tab→3D Settings→<Product Name
for NVCUDA>.

Cursor speed and shake gesture

Pressing MB1 and shaking the mouse from side to side is a new gesture called UGUI_MOUSE_SHAKE.
This new gesture is reported to GIT clients whenever a user shakes the mouse.

An API is implemented to provide the value of the pointer speed at a given mouse movement gesture.
This data is only valid if the current gesture is UGUI_PRE_POSITION or UGUI_DRAG_POSITION.

Navigate tool is retired

The Navigate tool is retired. You can explore your design in 3D space using Fly-through.

Product Notes
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Caveats

Bookmarks

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray
Traced Studio mode is not in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark
is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and

2. the number of views in the layout at the time when the bookmark file was created is not the same
as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the
same bookmark file a second time corrects the number of views.

Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when
Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX
displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer
to the Teamcenter Environment Manager Help.

Caveats
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Caveats
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4. Customer Defaults
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Customer defaults

Customer defaults allow you to customize the operation of NX. The initial settings and parameters of
many functions and dialog boxes are controlled by customer defaults. You can view them by choosing
File→Utilities→Customer Defaults.

For a description of the new or modified customer defaults, see Customer Defaults for NX 1847.

For additional information on customer defaults, see System administration→Customizing the NX
installation→Customer Defaults in the NX online help. For a listing and description of all customer
defaults, see Fundamentals→Customer Defaults in the NX online help.

Customer defaults

4-2  NX Release Notes

© 2019 Siemens Product Lifecycle Management Software, Inc.

https://docs.plm.automation.siemens.com/data_services/resources/nx/1847/release_notes/common/en_US/graphics/fileLibrary/nx/cust_defaults/index.html


5. Design (CAD)
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Assemblies
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Caveats

Mirror Assembly

When you move a mirror plane while both the Mirror the absolute origin location of all mirrored
assemblies or components option and the Associative Mirror option are set, the location of the
mirrored assembly or components updates, but the mirrored absolute origin does not update.

Minimally Load - Lightweight Display

The following caveats apply when you load assemblies using the Minimally Load - Lightweight Display
option:

• Avoid using this load option with the Structure Only load scope. You may experience lower load
performance when you use them together to load components from the Assembly Navigator, or
in conjunction with the Open by Proximity command.

• If you use this load option to load assemblies that have the following characteristics, the
components will be loaded partially instead of minimally:

o Pre-NX 9 components
o Components without NX datasets (JT components)
o Geometry overrides
o Position overrides
o Suppression overrides
o Reference-only components
o Assembly-level facets

• The associativity between multi-CAD override geometry and NX objects, such as PMI, will not be
maintained when assemblies are loaded using the Minimally Load – Lightweight Display
assembly load option.

Component patterns

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX
ignores this setting if the active window's root part or any of its subassemblies contain any component
patterns. When you move components in this situation, the Move Component command behaves as
though the Move Component Scope customer default is set to Work Part Only.

When a subassembly of the active window's root part contains a component pattern, inserting a motion
step in your sequence that affects a member of the component pattern may cause incorrect movement
of the following:

Caveats
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• Members of the component pattern.

• Components directly constrained to the pattern members.

• Components indirectly constrained to the pattern members.

Note:
When component patterns are present only in the active window's root part, the Insert Motion
command works correctly.

Reflect Component

You can't:

• Create a component pattern for reflected components.

• Export reflected components using the Export VRML command.

• Use NX 12.0.2 assemblies that contain reflected components in NX 12 or NX 12.0.1 because they
don't support reflected components.

Reflected components are limited or aren't supported in some applications and tools:

CAM CAM doesn't support assemblies with reflected components. Although you can
perform programming on reflected components, the results may be unpredictable.

PTS Product Template Studio (PTS) templates don't support moving reflected components.

Motion You can't start the Motion application if your assembly contains any reflected
components.

Simcenter 3D
3D Pre/Post

If you start the Simcenter 3D 3D Pre/Post application, all reflected components are
removed from your assembly.

Vehicle
Design tools

Vehicle Design Automation does not recognize reflected components in transformed
positions. Therefore, component geometry is calculated in each reflected component's
absolute position.

Fixture
Planner and
Line Designer

For Fixture Planner and Line Designer, we recommend disabling assembly reflection for
the following reasons:

• We believe that it doesn't make sense to use reflected components for any
equipment in the plant structure or Bill of Equipment, because such equipment
isn't purchasable. For example, robots or conveyors aren't available in reflected
versions.

Caveats
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• Downstream applications like Process Simulate don't support reflected
components in the plant structure.

• For Fixture Planner, reflected assemblies in the product structure aren't supported
because features like weld points and locators must have unique identifiers for
left-hand and right-hand parts. Features and locators must also be associated to
either a right-hand part or a left-hand part.

Caveats
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Drafting

Caveats
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Product Notes

Open Source Font Library upgrade

The FreeType open source font library is upgraded to version 2.9.1. This update may result in minor
display differences with some of the supported fonts.

Product Notes
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Caveats

Multiple part display caveats

The display of your drawing in an inactive window may be affected if you switch to an application that
only supports the display of content in the active window.

Caveats
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Layout

Caveats
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Product Notes

Create from 3D

When you use the Create from 3D  command, you can now select lightweight components without

first setting the Load Smart Lightweight Data customer default. Assembly performance improvements
made that default obsolete in NX 12.0. Now smart lightweight data is loaded whenever NX needs it to
complete an action.
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Product and Manufacturing Information (PMI)

Product Notes
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Product Notes

Open Source Font Library upgrade

The FreeType open source font library is upgraded to version 2.9.1. This update may result in minor
display differences with some of the supported fonts.

Product Notes

5-12  NX Release Notes

© 2019 Siemens Product Lifecycle Management Software, Inc.



Data Reuse

Product Notes
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Documentation Notes

Selecting an existing CADENAS part

In the Reuse Library help, in the CADENAS Library section, the Select existing part topic erroneously
states that only the parameters for a CADENAS part created in your current assembly are displayed in the
Select Existing Part dialog box. In actuality, NX displays parameters for all versions of the CADENAS part
created in any of your assemblies.

Documentation Notes
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Routing

Documentation Notes
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Caveats

Placement of eccentric reducers

If the NPS and NPS_BRANCH attributes are not present on the ports of a reducer, you might not get the
correct placement solution while placing the pipe. If you place such a part, you might not be able to
move it as expected using the Move Part command.

Moving parts

You cannot move a routing component using the Move Part command if the customer default for the
selection scope of the Move Component command is set to Anywhere in Assembly.

Tip:
To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Color bleeding in harness displays

If the color bleeds through in the display of harnesses, use the Refinement Factor visualization
preference to correct the display. The factor you must set varies depending on the part that is open.

In the Visualization Preferences dialog box→Faceting tab→Part Settings group, use the:

• Shaded Views subgroup→Refinement Factor option to adjust the display in a shaded view.

• Advanced Visualization Views subgroup→Refinement Factor option to adjust the display in
advanced studio views.

Teamcenter Classification

The Teamcenter Classification plug-in is now obsolete. You can use the out-of-the-box support for
classification by setting the Teamcenter classification options in the Part Library customer defaults.

Tip:
To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find

Default .

Caveats
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You can use the Reuse Library for classification without setting up additional plug-ins.

Bend radius table text (.txt) files

Bend radius table files are no longer supported in .TXT format. You can only import bend radius data in
Excel spreadsheet (.XLSX) format. The current documentation still covers the text file option, but any
documentation referencing bend radius table files in .TXT format will be removed in the subsequent NX
release.

NX Routing dataset name

On the Managing Routing configuration files in Teamcenter and NXRouting datasets page, the term
NXRouting dataset should read NX Routing dataset, (with a space between NX and Routing). This
correction will appear in the documentation for the subsequent NX release.

Caveats
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Documentation Notes

Structure of a PTB file

The topic Structure of a PTB file erroneously states that NX uses the descriptor characteristics in the list
of table columns in a PTB file to search for parts in the Routing Reuse Search dialog box. In reality, NX
only displays the characteristics in the Routing Reuse Search dialog box. The switch /HIDE indicates that
you do not want NX to show the characteristic in the Routing Reuse Search dialog box during part
placement.

Note that the destination characteristics defined under specific disciplines in the APV file are used when
you search for parts. This is not necessarily the same as what is displayed.

Unify Path enhancement

In previous releases, NX did not unify paths when direct mount parts or eccentric segments were a part
of your selection. Parts that were placed using the Instance Name Lookup command and which were
part of a run were ignored when you used the Unify Path command.

In NX 9.0.2 and later, in addition to the conditions mentioned above, NX does not unify a path that has
an eccentric reducer part or any other routing part which has the NX_BLOCK_UNIFY attribute set to
TRUE in the respective PTB file.

Parts which are placed using the Instance Name Lookup command  are now ignored when you use the
Unify Path command, even when the parts are not part of a run.

Documentation Notes
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Product Notes

Propagation of attributes on a run

NX does not automatically propagate attributes that are specific to a run to the Member items of the
run.

To see all the run-level attributes of the member of a run, such as a component or a segment, right-click
the object in the graphics window and choose Report Run Attributes.

Renaming stock components in Teamcenter Integration for NX

To change the name of a stock component that is not yet saved, use the Rename Stock  command.

To change the name of a stock component that is saved, use the Make Unique  command or the

Save As →New Item command.

Installing standard parts to Classification in Teamcenter

You can install standard parts to Classification in Teamcenter by using the Classification Install for Part
Library tool provided in the following folder:

UGII_BASE_DIR\ROUTING\ugroute_mech\classification_tool

Opening pre-NX 10 parts in later releases

Opening pre-NX 10 parts might take longer when you open the part for the first time in a subsequent
release.

Upgrade Stocks command

When using the Upgrade Stocks command on a part that uses Stock As Components and that has
multiple levels of Routing assemblies, we recommend that you select the Work Part and Loaded
Children Parts  check box.
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NX Routing - Stock materials and weights

With NX, Routing now supports automatically assigning materials to stock bodies. This has the same
result as if the user used Assign Materials and selected a material from the library. Use of this has
ramifications for mass and weight calculations.

1. If Material is set, then density is fixed.

Assigning a material also sets and locks the corresponding density of the material on the stock
body.

a. The stock solid body must accurately represent the volume of the real stock.

• If using the Simple stock display style, use Qualify Part to include the inner wall in the
cross-section. (Essentially making it a Detailed stock style.), or never use Simple style.

• Make sure that Detailed style is defined with the inner wall correctly. (Display styles are
customer configured and can include any geometry)

2. WEIGHT and WEIGHT_UNITS can still be used. WEIGHT here is mass per unit length (for example,
its unit can be kilogram per meter). These attributes are used by Routing to automatically adjust
the density of stock bodies so that mass calculations are correct regardless of the solid
representation with Simple or Detailed stock display styles. This is incompatible with setting the
Material which sets and locks the density.

a. If WEIGHT is found as a stock attribute, Routing uses it to set density as in prior releases and
will not assign the Material. Material will be ignored.

b. Material can still be set as an attribute on the stock, but the attribute title cannot match the
NX Material attributes. That is, it will be treated like any other attribute. That is, decouple the
NX Material attributes from the Routing stock attributes.

• In Customer Defaults, under the Gateway→Materials/Mass node→Attributes tab,
review the Attribute Title Alias entries for Part Material and Object Material. Verify
that these entries do not match any PTB/Classification attributes for stock. Verify the APV
configuration file for synonyms to attributes

• Rename any matching attribute names.
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Note:
In Routing Electrical, routed wires and cables are bundled together and represented collectively by
a solid body. No material is assigned to these bodies, regardless of stock attributes. WEIGHT, and
WEIGHT_UNITS attributes on wire and cable stocks can be used so that Routing will determine
and set a density value that results in correct weight calculations for these bundle bodies. This is
the same as in pre-NX 12 releases.

NX Routing part materials and weights

Routing parts are different from stocks, as parts are standard, and routing does not create them.

Prior to NX 12, Routing would set PTB/Classification attributes with Material as regular attributes. That
is, component or instance attributes. This was inconsistent with interactive Material assignments, and
for many reasons allowed inconsistent and undesirable behaviors. A WEIGHT attribute in the PTB/
Classification was similar.

In NX 12, Routing will no longer set Material attributes on components or instances. Since routing parts
are customer created and managed parts, it is recommended that the bodies within these parts, and/or
part families have Materials properly assigned there at the source if Material assignment is desired.
Part families support Material assignment with the part family table so that each family member can
have its own material.

Weights/Mass can require trade-offs. If a Material is assigned to the body, the density is set and locked,
and the mass properties are calculated accordingly. If the part is modeled accurately, that is, with the
correct volume, then the mass properties will be correct. However, in many cases, as these are standard
parts, it is not required or desired to model them with complete accuracy. Also, complete details may
not be known. These simplifications likely render the volume, and therefore may compute mass
incorrectly.

One solution can be part families. Part family tables support Asserted Mass, where a mass value can be
set. However, only the mass itself can be asserted; center of gravity location, and moments of inertia
cannot. Any analysis of assemblies using these parts can have accurate masses, but CG and Moments
will be marked as certain with no values.

Another solution used today is an unsupported utility provided by Routing, UFD_Routing_assert_mass.c.
This utility takes a WEIGHT attribute provided in the part family table, and fills in values in a DENSITY
column in the part family. These values are set by analyzing each part family member’s volume and
determining the density required to get the desired WEIGHT. When a part family member is created the
density is set, and regular NX weight calculations are used. There are inherent assumptions in this
method, but it generally holds valid. However, this is incompatible with Material assignments. You can
either assign the Material and take the material density, or set a density value and not assign a
Material, but never both.
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Summary

• If parts are modeled completely and correctly, Material can be assigned to bodies without any
issue, and mass calculations will be correct.

• If mass calculations are not important, Material can be assigned to bodies without any issue.

• If parts are simplified, and only mass, not center of gravity or moments, is needed, then Assert
Mass, Assign Material in part families or to individual parts can be used.

• If parts are simplified, and complete mass properties are required, then the mass utility can be used
but Material cannot be assigned.

NX12 locked length spline behavior

Locked length splines behave differently in NX12 than in earlier releases of NX. For example, in NX11, if
you add a deformable routing assembly containing a locked length spline to a part, and then move one
end of the deformable assembly, the other end of the assembly will move with it to maintain the spline’s
locked length value. With NX12, when you move one end of the deformable assembly, the other end of
the locked length spline does not move. As a result, the spline may stretch beyond its locked length limit
and trigger a design rule violation. This behavior ensures that repositioning a deformable routing
assembly does not move any other device in the assembly that it is attached to.

Defining splines using wave-linked ports

When modifying the direction of a wave-linked port, for example, rotating the component that owns the
port, the path direction will not update even if it is constrained properly. The direction can be forced to
update by suppressing or unsuppressing the parallel constraint associated with the port or extension.

Importing runs

The Import Runs page has been updated to include P&ID. It now states:

You can share runs between schematics applications such as COMOS, P&ID, and NX.

Retired functionality in Routing

The following are retired:

• Active Routing Level Routing preference
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• Display Segment Constraints Routing preference

• Manage Associative Paths command

• By Poles option in the Spline Path dialog box

• Variant Conditions command

• Variant Configurations command

• Convert Splines  command

The following Routing plug-ins are retired:

• ROUTE_CREATE_FABRICATION

• XML_PREIMPORT

• XML_POSTEXPORT

• SPLIT_DESCRIPTORS
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Ship Structure

Product Notes
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Caveats

Copy Parts between Planes

The Copy Parts between Planes command does not support Extrude features that are created using
the Stop at Intersection selection rule.

CAE Preparation

The Openings Less Than Diameter option in the CAE Preparation dialog box is currently not
supported.
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Sheet Metal

Caveats
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Caveats

Patterning of a gusset on non-cylindrical bends

When a gusset is on a non-cylindrical bend, you cannot create a pattern of the gusset.

Note:
This is applicable only for gussets created using Automatic Profile.

To create a pattern of a gusset that exists on a non-cylindrical bend:

1. Extract the curve of the mold edge of the non-cylindrical bend.

For example, use Offset Curve in Face to extract the curve.

2. Use the extracted curve for defining the plane location and create a gusset.

3. Pattern the gusset using the extracted curve as a path.

Tip:
To do this, use Along in the Layout list.

Bridge Bend

You cannot create a bridge bend if the two sheet metal bodies intersect in the following way:

• A body from which you select an end edge intersects with the non-planar web face of the parent
body of start edge.

1 Start edge
2 End edge
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Convert to sheet metal

If you create a fold transition between the planar web faces of chained bends and convert the body to a
sheet metal part, the conversion may be partially successful.

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO
format.

Creating multiple flanges

While creating multiple flanges, if adjacent flange edges are not in the same set, you cannot apply an
internal miter.

Unite in Sheet Metal

If you unite bodies that consist of Sheet Metal and advanced Sheet Metal features, the united body may
not support subsequent Sheet Metal operations.

Material and Bend tables

The tool selection options are not available for the following commands and options.

• Hem Flange

• Lofted Flange

• Convert to Sheet Metal

• Bridge Bend→Type group→Z or U Transition

Bridge Bend→Type group→Fold Transition→Bend Properties group→Define By list→Length
option

• Advanced Flange→Type group→To Reference
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Human Modeling

Caveats
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Documentation Notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download,
which let you work through detailed instructions on your own. These hands-on procedures are a good
learning tool to try out new functionality and complex workflows. The procedure topics are titled
Hands-on: <Procedure name>.
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PCB Exchange

Documentation Notes
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Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If
the board is an assembly component this workflow does not work.

PCB Exchange for Zuken

CR5000 Data Server version 17 or later requires the Visual C++ 2012 Redistributable package to be
installed. You can download it from the Microsoft website.
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6. Manufacturing (CAM)
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Manufacturing Product Notes
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Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in
NX documentation.
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CAM Early Access program

Some of the new NX CAM features are available only upon request through the CAM Early Access
Program. In order to learn more about these pre-release features, please contact GTAC. GTAC will
forward your request to the appropriate development contact.

The early access features available in the current release include the following:

• GMC subop support for the Teach Operation Sets and Create Feature Process commands

• Tool axis range definition in MCS

• Hole making in-process workpiece: Blank thickness

• Hole making predefined depth: Control point reference

• Turning: Multi-channel operation

• Turning: Feed rates from chip thickness

• Split IPW: Define automatic scrap detection

• Verify 3D: Store collision checks as findings with the tool path

CAM Early Access program
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Tool path and template changes

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements,
and improve reliability. In many cases, you may see some differences between the new path and the old
path when you generate an operation from a previous release. If you rely on automatic methods, these
changes should be acceptable. The end result of the new path should be comparable to, or better than,
the previous path.

To prevent accidental changes to tool paths in part files from a previous release, use the Lock Tool Paths
During Version Upgrade customer default. This option automatically locks all operations with an edit
status of Complete or Repost.

Maintenance release template changes

By default, the template part files for a main release are stored in the mach/resource/template_part
folder. Template part files for maintenance releases are stored in the mach/updates/template_part
folder.

CAM configuration changes

• No changes

Operation template sets

• No changes

Operation template parts

Changes apply to English and metric template parts.

• In library_dialogs.prt, and multi_axis_deposition.prt, added the MATERIAL_EXTRUDER  tool.

• In the following template parts, for the listed operations, added a Coolant Type option for open
and closed areas.

Tool path and template changes
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o mill_contour

CAVITY_MILL, CORNER_ROUGH, and REST_MILLING operations

o mill_planar

FLOOR_WALL, FLOOR_WALL_IPW, PLANAR_MILL, PLANAR_PROFILE, CLEANUP_CORNERS,
FINISH_WALLS, and FINISH_FLOOR operations

o In mill_multi-axis.prt and mill_multi_blade.prt, added the new MERGE_PATH program
subtype. Also created separate method subtypes for blisks and impellers. For example, there is
an IMPELLER_HUB_FINISH method, and a BLISK_HUB_FINISH method.

o In hole_making.prt, added the new GENERIC_FEATURE_OPERATION  operation.

Note:
To use the template, the person who has write permissions for the template parts must
do the following:

1. In the Operation Navigator, right-click the GENERIC_FEATURE_OPERATION node,
and choose Object→Template Settings.

2. In the Template Settings dialog box, select the Object can be used as a
template  check box.

3. Click OK to save the setting.

4. Save and close the template part file.

Customized templates

If you create your own template files, you must back up the files before you upgrade to the current
release. Copy the template files from the templates folder (%UGII_CAM_BASE_DIR%\mach
\templates\) to a separate location to prevent the installation from overriding your defined
templates.

After the upgrade installation is done, copy your template files to the %UGII_CAM_BASE_DIR%\mach
\templates location.

Tool path and template changes
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Merging customized templates

You can merge your customized templates with the templates included in this release in the following
ways:

• Start with the new default templates and apply your customizations. This is highly recommended
to ensure you receive all the PR fixes.

• Re-file your customized templates in the new release, review the changes listed for the release, and
implement the applicable ones in your templates. This method is not recommended, because you
will not receive the PR fixes.

Tool path and template changes
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General changes

Multifunction cutting tools

After a standard installation, multi-tool examples are now available in the tool library.

Machining data search in the Manufacturing Resource Library (MRL)

You can use the new mrl_feeds_speeds_config.txt configuration file to customize searches for
machining data, such as feeds and speeds, in the MRL database. For more information, see
Administering Teamcenter→Utilities Reference→Manufacturing utilities→Configuring the Machining
Data Library in the Teamcenter 11.5 online help.

Paste with Reference enhancements

The Paste with Reference command now supports wave links and the new manual drilling operations.

2D Dynamic collision display when verifying a tool path

In previous releases, rapid tool motions through the Part, Blank or IPW were displayed in the red gouge
color as material removed. In the current release, the material removal from these tool motions is not
displayed, so you will not see these collisions. To check for collisions, do one of the following:

• Click List after the simulation stops.

• Click Collision Settings. In the Collision Settings dialog box, select the  Pause on Collision
check box to stop the visualization when a collision occurs. This option does not work if you step
through the operation.

User Defined Operation and API Enhancements

The User Defined Operation API now has the ability to:

• Use the 3D milling IPW from a previous operation as the blank.

• Write level markers to the tool path. In verify, a tool path will have the ability to display one level at
a time, just like a Cavity Milling operation.

General changes
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Machine Tool changes

The standard machine tools supplied with NX have revised postprocessors and kinematics models.
Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX
8. If necessary, retrieve the machine tool again.

General changes
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Milling

Floor Wall operations

Releases previous to NX 12.0.1 used a negative stock value to define an additional depth for through
holes.

If you used a negative floor stock value instead of the current Z-Depth Offset value to define an
additional depth for through holes, and want to maintain the settings, set the following variable:

UGII_CAM_FW_INFER_FLOORS_NEG_STOCK =1

Milling
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Integrated Simulation and Verification (ISV)

ISV Simulation

• External file simulation in Teamcenter Integration for NX uses the same file selection box as native
NX.

• The Machine Configurator version 1.0.0.1027 supports the definition of valid file extensions. We
recommend that you use the latest version of the Machine Configurator, because future CCF files
shipped with NX will include such file extension definitions.

• The latest CCF files for the TNC and Fanuc controllers require the Python controller parser type.

When you set Implementation to Python, it is no longer necessary to redefine global variables
inside the driver. The driver now obtains the variables directly from the kinematics model.

Note:
If you prefer the library parser approach, use the CCF files from NX 11. You must define
global variables inside the driver for this approach.

ISV using CSE simulated controllers with Python parser

• The CSE Python parser is supported for Windows only.

This means that the standard examples supplied with NX will not run on non-Windows operating
systems. As a workaround: Inside the Machine Configurator, in the Global Settings dialog box,
change the Implementation setting for the MCF from Python to Library.

• For existing simulations using Python parser with encrypted files from older versions, for example
NX 9 or NX 10, we recommend that you use the un-encrypted *.py files from the latest release.

Integrated Simulation and Verification (ISV)
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Turning

Threading operations

When you machine conical threads with multiple starts, the engage and retract behavior is different.
This is because NX now calculates the pitch distance of conical threads along the centerline of the cone.
In versions prior to NX 11, NX calculated this distance parallel to the surface of the cone.

Turning
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Hole machining

Feeds and Speeds - Set Machining Data

For a step drill tool, NX calculates the spindle speed based on the tip diameter.

Back Counter Sinking operation

The collision check fails if you do not use a pre-drill operation, or when the pre-drilled hole is too small.
This is because the spindle is in non-spinning mode when it moves through the hole, and non-spinning
tools do not report collisions.

Hole machining
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Feature-based Machining (FBM)

Feature teaching no longer supports the Inferred CSYS subtype.

Feature-based Machining (FBM)
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Post

Library posts installed with NX

The Post Builder postprocessors are removed from the standard library machine tools, simxx, delivered
with NX. If an existing CAM setup refers to a library entry that used the Post Builder posts, it will not
work. You must do one of the following:

• Replace the machine tool with a library entry that uses the Post Configurator post.

• Copy the post from NX 12.0.2, and add it to the current NX library.

Post Configurator and TCL

As of NX 12.0.1 MP1, the NX CAM tcl version is upgraded from TCL version 8.4 to version 8.6. You may
need to update your company's tcl files because TCL version 8.6 has a stricter grammar check.

We recommend that you always edit the Post Configurator postprocessor tcl files in the Post
Configurator tcl editor. If you use your own text editor, set the encoding to UTF-8 without BOM.

Post
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Machining Line Planner

Manual sequence constraints

A new panel is added to the NX Machining Line Planner (MLP) tree view to edit sequence constraints.
These sequence constraints help you to correctly allocate operations to the setups.

Design change workflow

There is a new workflow to enable introducing a changed part file in an existing machining line.

Machining Line Planner
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Manufacturing critical maintenance and retirement notices

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author
(PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX
installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens
NX→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI
architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance. The Drill template has been hidden by default, but is still
available.

The following operations and geometry objects in the Drill template are affected:

• DRILL_GEOM

• SPOT_FACING

• SPOT_DRILLING

• DRILLING

• PECK_DRILLING

• BREAKCHIP_DRILLING

• BORING

• REAMING

• COUNTERBORING

• COUNTERSINKING

Manufacturing critical maintenance and retirement notices
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• TAPPING

The hole drilling operation introduced in NX 9 should be used instead of the Point To Point module. The
new method to manually drill holes will fully replace the Point To Point module over the course of the
next one to two releases.

The migration of Point To Point operations is not committed at this time, but will be considered for a
future release.

The new method to manually drill holes not only replaces the Point To Point module, but it also includes
new capabilities such as:

•  Sequential Drilling

•  Deep Hole Drilling

•  Back Countersinking

•  Hole Chamfer Milling

•  Hole Milling and  Boss Milling

•  Thread Milling and  Boss Thread Milling

•  Radial Groove Milling

Manufacturing critical maintenance and retirement notices
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Manufacturing critical maintenance and retirement notices
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Manufacturing documentation notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download,
which let you work through detailed instructions on your own. These hands-on procedures are a good
learning tool to try out new functionality and complex workflows. The procedure topics are titled
Hands-on: <Procedure name>.

Manufacturing documentation notes
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Manufacturing caveats

Manufacturing documentation notes
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General caveats

Reflect Component

NX CAM does not support the new Reflect Component assembly command in NX 12.0.2. If you use any
geometry from a reflected component for your operation, the results may be unpredictable.

NX CAM plans to support the Reflect Component command in a future release.

NX process

When you exit NX, it may close the UI without stopping the process. There is no data on how
widespread this problem is.

Work Instructions

Do not include Documentation operations as the target for the following commands, as unexpected
results may occur.

• Parallel Generate

• Replay

• Object Transform

• Simulate

• Gouge Check

• Verify

Shop Documentation

Each time you create Shop Documentation , NX generates facet bodies. To reduce the size of your

part file, delete the facet bodies before saving it.

Command Finder: Faceting

General caveats
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Tilt Tool Axis

Problem Workaround

Shortest 2D distance to curve

For longer tool paths, the shortest distance calculation can
become unsynchronized.

Use the 3D shortest
distance option.

The tilted tool path may have non cutting moves with lifts in
regions where they are not needed, and the moves can cause
gouges.

None

IPW

• A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a
Machine Control subop with a Set Modes event at the beginning of the GMC operation does not
change the machine mode state of the IPW. The previous machine mode, either milling or turning,
remains active.

If the preceding operation does not have the required machine mode, you must add an operation
with the required machine mode before the Generic Motion operation. For example, if the Generic
Motion operation is for turning, add a turning operation. The new operation must generate tool
path, but does not need to cut material.

Note:
This is not a limitation in ISV when you use the CSE driver. The machine state is defined by
the workpiece spindle setting, which is either turning or milling.

• The IPW calculation is inconsistent:

o For Verify and Simulate, rapid motions do not remove material.

o When you generate the tool path for operations using the IPW, rapid motions can remove
material.

This difference can result in unexpected results, for example when you use Show 3D IPW.

General caveats
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Milling caveats

Rotary Floor milling

Problem Workaround

The Min. Lead Angle does not influence the tool path. None

Milling caveats
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Turning caveats

Physical Workpiece

The workpiece  icon to identify the physical workpiece in the Geometry view of the Operation
Navigator is not available.

Operation Navigator geometry view with Physical
Workpiece icon

Current Operation Navigator geometry view

 Machine zero main-MCS  Main

spindle local-MCS  Main part

(physical workpiece)  

  

 Machine zero main-MCS  Main
spindle local-MCS  Main part (physical

workpiece)  

 

Turning tools

The tool library does not support the following new parameters on the Holder tab of the Turning Tool-
Standard and Grooving Tool-Standard dialog boxes.

• (SH) Shank Height

• Definition Mode

• (CEA) Cutting Edge Angle

The tool library does not support the parameters on the new Adapter tab of the Turning Tool-Standard
and Grooving Tool-Standard dialog boxes.

For round shank holders, it is not possible to specify an adapter using only the Block Length, Block
Width, and Block Height parameters.

Turning caveats
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Hole machining caveats

Tapping operations

Drilling  and Tapping  are distinct operation subtypes. Although tapping cycles are available in

the Drilling operation dialog box, we recommend that you do not use a Drilling operation combined
with a tapping cycle. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the
required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

• The operation will not contain the necessary feature geometry parameters and in-process feature
volumes for tapping.

• You will have the legacy Point to Point output where the pitch is driven by feed rate.

Back Counter Sinking operation

The Gouge Checking option reports false gouges.

Hole machining caveats
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ISV caveats

Visualize 2D Dynamic

• If blank geometry is not defined, you must click Step Forward twice before NX asks for blank
geometry.

• The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the
graphics X server settings. For example:

NVidia Quadro and FX graphics drivers

In the XF86Config file, in the Device section, set CIOverlay to TRUE.

Simulation

• In certain cases the reported minimum distance of a clearance violation is not the closest distance.

• Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and
tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not
work in some cases.

There are also some cases in which the selected positions of rapid motions are not displayed
correctly.

• When the simulation runs in the history buffer, and the spindle speed Output Mode for an
operation is set to SFM or SMM to maintain constant surface speed, the simulation behavior can
be unreliable.

• When you use the Machine Code Based Simulation option for synchronized operations, Show

Tool Path  is supported, but Path Segment Selection  is not supported.

• When you use the Machine Code Based Simulation option in the sim09 machine tool, milling
operations using CYCLE800 may have unwanted 360-degree motions of the C-axis.

• When you use the External Program Simulation  option, and you replace a machine, the

software removes the selected external main program from the Program Manager dialog box. You
then lose all changes in the edited main NC code program.

ISV caveats
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As a workaround, save your main program before replacing the machine.

CSE simulation

• When there are multiple workpiece objects, the tool trace is always attached to the first component
classified as _WORKPIECE, and moves with the component. If the tool trace is displayed on the
wrong component, you can reorder the kinematics tree to place the required _WORKPIECE
component first.

NX uses the tool tip of the active tracking point, of the active tool, in the carrier.

o To set the active tracking point, use SetCorrectionSwitch/SetToolCorrection.

o To set the active tool, use activateNextTool.

• When dragging behavior is used (Kv >0), the display and the collision checking are not
synchronized.

The graphical display uses the dragged positions.

Collision checking and material removal are based on the ideal interpolated values.

This means that NX may report a collision that is not directly visible inside the graphics window.

• Sinumerik controller

Using the AXNAME command causes problems. As a workaround, use the CCF version from a
previous NX release.

• Fanuc and Heidenhain controllers

When working with tables configurations and swivel cycles, there are specific cases that can cause
a wrong solution.

Virtual NC Kernel (VNCK)

• When it reaches a breakpoint, the simulation may fail to stop or may not stop at the exact position
specified.

• Although the supported VNCK versions (2.6, 4.4, 4.5.2 and 4.7.4) are not officially released for
Windows 10, they usually run without any problems when you use HMI Operate. If the VNCK does
not boot after installing, please ensure that Windows Data Execution Prevention is not active for
vncksl.exe and vplc3172dp.exe.

ISV caveats
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1. Press the Windows key.

2. In the search box, type advanced system, and press Enter.

3. In the System Properties dialog box, click the Advanced tab.

4. Under Performance, click Settings.

5. Click the Data Execution Prevention tab.

To exclude the vncksl.exe and vplc3172dp.exe files:

1. Click Add.

2. Select the vncksl.exe and vplc3172dp.exe executable files.

The default location for both files is the VNCK installation folder.

3. Click OK.

Note:
You must exclude the vncksl.exe and vplc3172dp.exe files for all installed VNCKs.

HMI Advanced

• HMI Advanced is always positioned in the top left corner of the Windows desktop. You cannot
move it from there.

• HMI Advanced is always on top of all other applications.

• Starting HMI Advanced resets Windows colors to a specific HMI Advanced color schema.

• When you run HMI Advanced, you can’t use function keys, such as F1, for other programs. The
function keys won’t work in the other programs until you exit HMI Advanced.

Additional restrictions:

• Windows 10 is not supported.

ISV caveats
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Positional ISV — Show Machine Axis Positions dialog box

When the setup has a multi-function machine and you use the dynamic manipulator to change the tool
axis for a fixed-axis operation, NX does not update the Show Machine Axis Positions dialog box. To
avoid confusion, use the Show Machine Axis Positions customer default to suppress the dialog box.

1. Choose File tab→Utilities→Customer Defaults.

2. In the Customer Defaults dialog box, choose Manufacturing→User Interface.

3. Click the Dialog Boxes tab, and in the Visibility group, clear the Show Machine Axis Positions
Dialog  check box.

Generate IPW with Path customer default

Using the Generate IPW with Path customer default may cause commands that require the IPW, such as
Verify, to have problems when the IPW is not complete. This can happen because the IPW takes more
time to generate than the operation.

ISV caveats
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Post Configurator

DEF File Editor

The editor removes comments from the main definition file, including any existing comments.

Canned Cycles

The drilling depth output is wrong if the depth is deeper than 99 mm.

Output of spindle orientation for back bore operation

The spindle orientation might be wrong in some situations.

UDE Rotate

The postprocessor might crash in some cases when you add UDE Rotate to the operation.

TCPM prepositioning plane

When this option is activated, the plane output for the prepositioning is wrong in the following case:

• There is only one MCS in the Geometry View of the Operation Navigator, and

• The MCS is defined as Local, and

• Special Output is set to None.

Post Configurator
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Feature based machining caveats

Teach Feature Mapping, Teach Operation Sets

Limitations and workarounds:

When you Teach Operation Sets does not
use

Workaround

Run Teamcenter Integration for
NX, and store the operation
templates in Teamcenter

The correct operation subtypes • Manually add the missing
tool classes and operation
subtypes to the generated
machining rules using the
Machining Knowledge
Editor.

• Replace the missing
subtypes and classes. To do
this:

1. (Optional) Change
your CAM
configuration to use
native operation types
and the standard ASCII
tool library.

2. Use Teach Operation
Sets to teach the
operations.

3. Use the Machining
Knowledge Editor to
add or optionally
replace the tool classes
and the operation
subtypes.

Use a library other than the
native ASCII library, such as MRL
or TDM

The tool class

Feature based machining caveats
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Fixture Planner

Feature based machining caveats
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Product Notes

Template files

The Open dialog box displays only installed templates. You must import the standard template part files
delivered with Fixture Planner into the Teamcenter database, so you can access these files in the Open
dialog box. Other templates are not configured to work with Fixture Planner

A setup script for installing Fixture Planner templates in Teamcenter is included with NX:
%UGII_BASE_DIR%\MANUFACTURING_PLANNING\templates\tcin_fixtureplanner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help.

Platform support

Fixture Planner is currently supported only on the Windows platform.

Manufacturing Additions installation

Using Fixture Planner with Teamcenter also requires you to install the Manufacturing Additions package
to Teamcenter server installation (ManufacturingAdditions 2.5). Find the ManufacturingAdditions 2.5
package in the Download or Upload Files section of the Siemens PLM Software download server.

You are prompted to use your webkey credentials to proceed.

Instructions for applying the ManufacturingAdditions 2.5 package are included in the package .zip file.

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start.

The Windows package is at the following location:

Teamcenter and Teamcenter Rapid Start→ Full Products→ Integrations and Solutions→ EasyPlan
And MfgAdditions→ 2.5→ TC10.x_ManufacturingAdditions_2.5_wntx64.zip /
TC11.x_ManufacturingAdditions_2.5_wntx64.zip

The Linux package is at the following location:

Product Notes
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Teamcenter and Teamcenter Rapid Start→ Full Products→ Integrations and Solutions→ EasyPlan
And MfgAdditions→ 2.5→ TC10.x_ManufacturingAdditions_2.5_lnx64.zip /
TC11.x_ManufacturingAdditions_2.5_lnx64.zip

Find instructions for applying the Manufacturing Plant extensions in the package .zip file (Plant
Extensions - Deployment Guide.pdf).

Data requirements for Export

When you export the study, it should have the data with or without NX part files. You should save the
study in the Fixture Planner before the export.

Note:
You should perform Save All for the study in NX, so you can see all the required part files in the
study.

Product Notes
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Documentation Notes

Note the following about the Fixture Planner documentation:

• Fixture Planner works with BVR data structures, and the documentation describes BVR procedures
wherever required.

In the release notes, you can find Fixture Planner in the CAM section.

Documentation Notes
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Caveats

Importing Fixture Data

You can make changes in the fixture assembly data in native NX and then import only the fixture
assembly in managed NX. This import allows the exchange of the relevant changes within the fixture
assembly, and lets you update the planning scope of Fixture Planner.

Data requirements for Import

After making changes in the fixture assembly in native NX, when you import back the changes of
the fixture assembly to managed NX, the scope of the import should be the Fixture Assembly only,
and not the study.

Caveats
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Line Designer

Caveats
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Product Notes

Template files

You must import the standard part files delivered with Line Designer into the Teamcenter database, so
you can access these files in the New Item dialog box. If you do not perform this step, the New Item
dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX: %UGII_BASE_DIR
%\MANUFACTURING_PLANNING\templates\tcin_linedesigner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help at the
following location:

Home→ Teamcenter Integration for NX→ System Setup/Administration→ Server Setup/Administration→
Installing/creating/modifying templates→ Installing File New templates

Platform support

Line Designer is currently supported only on the Windows platform.

Data Upgrade

Due to changes in the connector design in NX 11, equipment that uses connectors created before NX 11
must be upgraded to NX 11 or later format. To do this, we recommend that you open and save the
equipment in NX 11 or later.

Equipment that uses connectors created in NX 11 is upgraded automatically in NX 12.

For more information, see Using library components with connectors from NX 11 or earlier in the Line
Designer caveats.

Manufacturing Additions

Manufacturing Additions includes Teamcenter extensions to support the following:

4GD Support Use of Line Designer with 4GD capabilities requires a Teamcenter extension called 4GD
Plant Design.

Product Notes
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FactoryCAD
Library
Migration

Migrating libraries from FactoryCAD to Line Designer also requires a Teamcenter
extension to support new required dataset types. This extension is included in the
Manufacturing Additions package to Teamcenter installation (ManufacturingAdditions
2.5).

You can get the Manufacturing Additions package to support 4GD and FactoryCAD Library Migration
from the Download or Upload Files section of the Siemens PLM Software download server.

You are prompted to use your webkey credentials to proceed.

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start.

The Windows package is at the following location:

Teamcenter and Teamcenter Rapid Start→ Full Products→ Integrations and Solutions→ EasyPlan
And MfgAdditions→ 2.5→ TC10.x_ManufacturingAdditions_2.5_wntx64.zip /
TC11.x_ManufacturingAdditions_2.5_wntx64.zip

The Linux package is at the following location:

Teamcenter and Teamcenter Rapid Start→ Full Products→ Integrations and Solutions→ EasyPlan
And MfgAdditions→ 2.5→ TC10.x_ManufacturingAdditions_2.5_lnx64.zip /
TC11.x_ManufacturingAdditions_2.5_lnx64.zip

Find instructions for applying the Manufacturing Plant extensions in the package zip file (Plant
Extensions - Deployment Guide.pdf).

Factory resource samples

Installation of the sample factory resources, conveyors, and robots from the manufacturing resource
sample library to Teamcenter is highly recommended.

Factory Resources Factory Conveyors Factory Robots

Instructions for installing the samples are located in the following section of the Teamcenter HTML
documentation:

Product Notes
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Home→ Installing→ Installation on Windows Servers Guide→ Adding Features→ Manufacturing→
Installing and configuring the Manufacturing Resource Library

Manufacturing Resource Library version compatibility

Line Designer supports the use of factory resources with compatible versions of Teamcenter and
Manufacturing Resource Library (MRL), as shown in the following table.

Note:
You should always upgrade the Manufacturing Resource Library components from the previous
release to the new release.

Upgrading smart objects to the current NX version

NX will automatically upgrade the older version of smart objects from previous NX releases to the new
version when they are opened and saved in the new version of NX.

Product Notes
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Documentation Notes

Note the following about the Line Designer documentation:

• Line Designer can work with either BVR or 4GD data structures, and the documentation describes
BVR and 4GD procedures separately wherever required.

In the release notes, you can find Line Designer in the CAM section.

Documentation Notes
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Caveats

Configured components in the Plant Navigator

Configured out components from the plant structure appear as loaded components with no graphics in
the Plant Navigator.

Using library components with connectors from NX 11 or earlier

While placing or disconnecting components in a layout, or while dragging components to another
layout, you may experience incorrect behavior if those components have connectors created in NX 11 or
earlier.

Recommenda
tion

Before using the library objects in NX 12 or later Line Designer layouts, you should
upgrade any part files of the library objects that include connectors created in NX 11 or
earlier. To do this, open and save the library objects in the later version.

Editing smart components in a layout

In a layout, when you edit a floor component or a platform component from the Reuse Library, the
geometry of that component disappears.

Workaround Change the reference set of that component, from Model to Entire Part.

Dragging in the Plant Navigator

In a layout, when you drag any component from the Reuse Library to a large assembly (approximately
5,000 components) in the Plant Navigator, you may observe a performance issue in refreshing the
layout in NX, as the layout takes more time to load.

Moving the components in the Plant Navigator

In a layout, when the components are set with the assigned pose and you move them using Fast
Placement, the components lose their pose.

Loading the plant layout with connected components

While loading the plant layout with connected components, you may observe the components as
disconnected in the Plant navigator. The remedy to this issue is to restart the NX session, and again
load the same plant layout.

Caveats
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Loading the plant layout with assembly load options

In Line Designer, while loading a layout using assembly load options, you may observe the following
behavior.

Structure Only

When you load a shared study, NX does not support partial loading of the layout and its components
in a Structure Only option.

Caveats
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Additive Manufacturing

Caveats
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Product Notes

Templates

If you created your own template files in an earlier version of NX, you must do this before you upgrade
to NX1847: copy the template files from the templates folder (%UGII_CAM_BASE_DIR%\mach
\templates\) to a separate location to prevent the installation from overriding your defined
templates.

After the upgrade installation is done, copy your template files to the %UGII_CAM_BASE_DIR%\mach
\templates location.

New version of Build Processor Interface

You must install the updated 3.0 version of the Build Processor Interface (BPI) when you upgrade to
NX1847. You will get this message until you install the BPI 3.0 version: Incorrect version of the
Materialise Build Processor Interface.

Before you install the BPI 3.0 version, uninstall the old BPI version and then install BPI 3.0 from this
location: %UGII_CAM_BASE_DIR%\mach\auxiliary\mfgam\BuildProcessorInterface.exe

You must restart your machine to complete the upgrade installation.

Product Notes
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Caveats

User-defined supports

When you move a part that has user-defined supports, the part is moved, but the user-defined supports
do not move.

Heat Sink support attribute

The Heat Sink attribute is currently not visible for gusset support structures.

Caveats
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Documentation Notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download,
which let you work through detailed instructions on your own. These hands-on procedures are a good
learning tool to try out new functionality and complex workflows. The procedure topics are titled
Hands-on: <Procedure name>.

Documentation Notes
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Additive Manufacturing Process Simulation

Documentation Notes
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Caveats

• The software does not yet support automatically generating compensated/deformed geometry
from computed deformations, for models created with convergent geometry.

• The application will run on a localized version of NX, but the deformation results (in case of solver
slicing) must be selected manually, except for the English, German or French versions.

Caveats
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CMM Inspection Programming

Caveats
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CMM release notes

PAX file change

The .pax files are now located in the UGII_BASE_DIR\cmm_inspection\templates folder.

VALISYS critical maintenance and retirement notice

The VALISYS application is unsupported as of July 21, 2016. Use the NX CMM Inspection Programming
application instead of VALISYS Programming and use CMM Inspection Execution instead of NX-Inspect.

Linking to PMI information

All geometry referenced by PMI must be in the current reference set, and if it is not, then NX:

• Issues warning messages in the information window.

• May still create features, but will not create paths because there is no access to the feature
geometry.

CMM release notes
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Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine
simulations within the Inspection Path dialog box to fail.

Machine simulation

When you create an inspection path or simulate a program, you may see the following INI Programs
message:

In order to handle INI files in the Program Manager, define the channels 
in the Machine Tool Builder.

You can ignore this message for NX CMM Inspection applications. It has no effect on the machine
simulation.

Caveats
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Caveats
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7. Simcenter 3D
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Simcenter 3D supported platforms

For information about operating system platforms supported by Simcenter 3D, see Operating system
requirements.

Note:
Simcenter 3D does not support the Mac OS X.

Simcenter 3D supported platforms
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Pre/Post

Simcenter 3D supported platforms
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Caveats

Selection recipes

You can use the Filter Elements adapter to filter out elements from a selection recipe that have a
particular physical property table ID or thickness value. If you change the thickness value or physical
property table ID in the Element Associated Data Manager dialog box for an element, these changes
will not modify the content of selection recipes that have a Filter Elements adapter defined.

Note:
If you change the thickness value or physical property table ID in the Element Associated Data
dialog box or use the Modify Associated Data command, this issue does not occur.

Edge Separation command

The following issues currently occur with the Edge Separation Condition command:

• (PR 9163646) If you create a 1D mesh on an edge that participates in an Edge Separation
Condition, that 1D mesh may be lost during the FEM update process.

• (PR 9157743) Currently, you cannot use the Edge Separation Condition command to select a set
of edges that form a closed loop. The current work around for this issue is for you to perform the
operation in two steps.

Isotropic and Anisotropic materials

In the Isotropic Material and Anisotropic Material dialog boxes, properties on the Electromagnetic
page, except for electrical Resistivity, are currently unsupported. These properties are used by
electromagnetic solutions that will be available in a future release.

Meshing

• The 2D Mesh from Facets command is intended to be used on geometry that is highly complex
and which the software cannot flatten into a 2D domain, which means that you cannot generate a
mesh on it using the traditional 2D meshing techniques. There are significant limitations to the 2D
Mesh from Facets command in that it does not offer the robust control that is supported by the
traditional 2D Mesh command. You can use the new 2D Mesh from Facets command together
with the 2D Mesh command, but there are some notable limitations.

The 2D Mesh from Facets command:

Caveats
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o Does not honor the location of mesh points.

o Honors only Size on Face and Size on Edge types of mesh controls. It ignores all other types
of mesh controls.

o Does not honor frozen mesh boundaries. As a result, the software:

■ Marks adjacent faces that you mesh with the 2D Mesh command for update when
create or update a mesh with the 2D Mesh from Facets command.

■ Updates faces that you mesh with the 2D Mesh from Facets command before it updates
faces that you mesh with the 2D Mesh command.

o Ignores Free Coincident type of mesh mating conditions.

Universal connections

• (PR 8382376) The software currently runs slowly when you change options within the Seam Weld
dialog box.

• (PR 8397606) If you created a Bolt Connection in Simcenter 3D 12 and used a selection recipe
with the Set of Curves option (Location tab) to define the bolt's' centerline, the bolt may not be
created correctly when you open the file in this release. To work around this issue, edit the Bolt
Connection and redefine the Set of Curves by removing and then reselecting the selection recipe.

Delete Unreferenced Entities command

In the Simulation file, the Delete Unreferenced Entities command is currently available in the user
interface but does not yet work. While you can use the Delete Unreferenced Entities dialog box to
select unused entities to delete, for example, when you click OK or Apply, the software currently issues
an error message.

Frequency Excitation Set

In the Frequency Excitation Set dialog box, in the Excitation group, if you specify an excitation field
that is based on magnitude/phase angle values, the resulting analysis will be invalid. To work around this
issue, in the Table Field dialog box, right-click the Magnitude/Phase column and select Display Real/
Imaginary to convert the excitation to a field based on real and imaginary components.

Simcenter Nastran FEM Acoustics and Simcenter 3D Acoustics BEM

• The Specific Duct Mode and Distributed Duct Mode commands are new in this release and
currently do not support solving in the Distributed Memory Parallel computation mode (DMP).

Caveats

NX Release Notes  7-5

© 2019 Siemens Product Lifecycle Management Software, Inc.



• (PR 8401291) In the Acoustics BEM environment, QUAD8 elements are not currently supported in
Mode Set alternate representations.

Specialist Durability

Specialist Durability currently has the following limitations:

• Currently, in the Computation Location dialog box, the Result Output Location, such as Nodes of
Elements, that you specify must fit the available stress data. The software currently cannot convert
nodal stresses to element stresses, or element stresses to nodal stresses.

• Although you can use the Durability Simulation Objects and Surface Residual Stress dialog
boxes to create and configure a Surface Residual Stress Parameter, the software's calculations do
not yet take the parameter into account.

• Seam welds are currently supported for 2D meshes only.

• Stress-based spot welds that have only spider elements at the weld location and no 2D elements
are not currently supported.

• The Solver Parameters and Solver Parameter Libraries commands on the Specialist Durability
ribbon bar are not yet functional.

Simcenter 3D Specialist Durability currently has the following known issues:

• In the Superposition Event dialog box, you cannot currently use Simcenter 3D Motion results to
define the load history data. To work around this issue, use the Flexible Body Event command to
specify the Simcenter 3D Motion results.

• In the Notch Stress Configuration dialog box, the Best Fit option in the Geometry Definition list
does not currently work.

• When you define seam welds, if the seam weld begins in a location where the orientation of the 2D
elements is very different from the rest of the seam weld, the software may not handle the side
information as expected.

• When you use force-based seam welds, Specialist Durability handles the correct fine matrix for
seam welds more strictly than LMS Virtual.Lab Durability. Therefore, Simcenter 3D Specialist
Durability may sometimes not detect all the matrices that are detected in LMS Virtual.Lab
Durability.

• In the Seam Weld Connection universal connection dialog box, if you use a vector to define the
Location of the connection (Weld Properties page), the Specialist Durability solver may fail to

Caveats
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start. To avoid this issue, select one of the flange/side options, such as Flange 1, Side 1, to define
the location.

• Currently, error messages that occur because the solution is not set up correctly do not provide
information on how to correct the problem.

• When you add Durability Simulation Objects to existing libraries, a warning message appears that
states that the library already exists and asks whether you want to replace it. This message is
incorrect. If a library already exists, the software appends the new object to the library if you click
Yes.

Laminate Composites

Memory management of the Ply Sketcher graphical display window is faulty and causes Simcenter 3D
2019.1 version 1847 to crash under the following conditions:

• Creating or modifying many plies in the Laminate Modeler or Solid Laminate Modeler dialog
box.

• Loading an existing Laminate or Solid Laminate physical property that contains many plies.

• Selecting a 2D element, 3D element, or polygon face associated to many plies in the View
Laminate dialog box.

• Manually resizing the window or using the Zoom slider in the Ply Sketcher tab of the Laminate
Modeler or Solid Laminate Modeler dialog box, or in the Ply Sketcher group of the View
Laminate dialog box.

This issue will be fixed in Simcenter 3D 2019.1 version 1851. For Laminate Composites applications, it is
strongly recommended to use version 1851 when it becomes available.

FE Model Correlation

• When there are more sensors than there are nodes in a FEM mesh at a given location, some of the
sensors may not be mapped. This is an unusual situation as there are generally more FEM nodes
than there are sensors, however it is possible especially with laser measurements.

• Resetting a Test Model alignment in a Simulation that was migrated from an earlier version of
Simcenter 3D results in an incorrect initial position.

• An intermittent units issue causes nodes of analysis reference solutions created from solutions not
using Simulation units (for example, in N-M instead of the Simulation units of mN-mm) to be
improperly scaled, resulting in a mapping failure with the work solution nodes.

Caveats
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FE Model Update

Memory management of the Sensitivity Viewer window is faulty and causes Simcenter 3D to crash
under the following conditions:

• Using the Scale, Targets, Min, or Max sliders.

• Manually resizing the window.

It is strongly recommended to save your model before using the Plot Sensitivities command.

Abaqus environment

Beginning in this release, Pre/Post supports the import of Abaqus assembly files that use dot notation to
define the relation ship between files in the assembly structure.

Currently, Pre/Post only supports importing two levels of assembly references. For example:

• Pre/Post correctly imports [instance_name].[entity_name/entity_label] because the file name has
two levels of assembly references.

• Pre/Post does not correctly import [assembly_name].[instance_name].[entity_name/entity_label]
because the file name has three levels of assembly references.

To workaround this issue, you can manually edit the ANSYS input file to remove the [assembly_name]
from the notation if the model is a single assembly.

LS-DYNA environment

When you import an LS-DYNA input file, the software does not import the material orientation for the
*ELEMENT_TSHELL_COMPOSITE keyword when the first ply material keyword has a negative AOPT
parameter, which means that its absolute value is Material Orientation Coordinate System Label. After
the import, only the first element in the mesh collector has a defined Material Orientation value. Other
elements do not have Material Orientation value, and the software places them into a different
element collector.

Simcenter Samcef environment

• (PR 8394509) The Solid Properties Check command does not work on composite elements.

• The following issues currently occur when you import a Samcef model into Simcenter 3D:

Caveats
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o (PR 7969581) During the import process, the software writes unused .FCT functions to the
User-Defined Text epilog. However, these functions retain their original numbering. This can
interfere how the software outputs functions if you export the model again.

o (PR 8389065) Subcases in which the computation times are defined in multiple time sets
(Samcef old .CAT T1 ... T2 command) do not import correctly.

o (PR 8394315) Rigid link elements that are defined on a single node do not import correctly.

o (PR 8393653) Bush elements defined on two coincident nodes are incorrectly imported as
grounded bush elements.

o (PR 8391285) .AXL coordinate systems in axisymmetric models that are defined with a single
node do not import correctly.

• The following issues currently occur when you export a model from the Simcenter Samcef
environment:

o (PR 9283611) You cannot enable or disable bidirectional Surface-to-Surface Contact in a
subcase.

o (PR 8396273) On the Composite Strain page in the Structural Linear Output Requests
dialog box, if you select Enable Total Strain, you can currently set the Location list to
Middle. However, Simcenter Samcef does not compute total strain results at the location for
2D elements.

o On the Damage page in the Structural Non Linear Output Requests dialog box, the Enable
All and Disable All buttons have no effect on the Scalar Total Damage option.

o (PR 8397406) The Thermal Strain output request does not save results on the Top and
Bottom locations of shell elements.

o The software does not export beam element offsets that are defined using Element
Associated Data.

Model and Load Pre-Processing solution process

The Model and Load Pre-Processing is a new solution process in this release and currently has the
following limitations:

• (PR 8377726) Scenarios that include mesh mapping, FFT transformation, and other options are
only supported on Windows platforms.

Caveats
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• (PR 8379623) You cannot use Test.Lab (.LMS) files to define loads, such as accelerations.

• (PR 9179430) You should use MKS units only. You must use the Advanced Solver Options dialog
box to set the unit system to (N)(m)(kg) when you solve Nastran solutions.

• (PR 9175937, PR 8378759) Journaling is not currently supported.

• (PR 8381974) The process monitor window and the log files do not update during the solution. The
software currently displays all messages when the solve completes.

• (PR 9197259) Time to Waterfall of Time Data results are shifted by one time step compared to
Virtual.Lab results.

• Performance issues currently occur when loading (PR 8380431) and unloading (PR8380589)
intermediate meshes, using the Time to Waterfall of Time Data command (PR 9191828, PR
8380901), performing FFT operations (PR 8380901), and when you edit large CGNS files (PR
8380633).

Margin of Safety

• The following Margin of Safety features are currently available in English only:

o The Simcenter 3D Aerostructures Standard Methods documentation that is available in
Simcenter 3D and accessible when you create an aero calculation.

o The calculation method input parameter names and the output type names.

• .(PR 8401481) In the Laminate Parameter Property dialog box, the Name column lists the
laminate parameters by their ID values and not their specified names. This occurs because this
dialog box generates an expression that should be usable all the times, even if the parameter
names change. This issue will be addressed in a future release so that the Name column lists user
specified names for the parameters.

• .(PR 9291468) Calculation methods with results that are output by load case do not currently work.

Flexible Pipe

• While you can undo the creation of Flexible Pipe features, you cannot redo them.

• To access a subpanel from a tree item in any definition panel, you must double-click the item rather
than press the Enter key.

• To close a subpanel of a definition panel, you must click the OK or Cancel button. You cannot press
the Enter key to close a subpanel.

Caveats
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• For a pipe of the type “Bundle”, the “Bundle\Bundle Tape Factor” coefficient is ignored: the default
value (=1) is always used.

Additive Manufacturing Process Simulation

• When you set the Mode option in the Mechanical Slicing dialog box to Solver, and you are
running this application on a localized language version of Simcenter 3D that is not English,
French, or German, the software cannot automatically open the Post Processing Navigator and
select and display a result at a particular time step. To work around this issue, you must manually
open the Post Processing Navigator and browse to the results that you want to display.

• You cannot use Additive Manufacturing Process Simulation to analyze an additive manufacturing
part that has components that contain multiple bodies.

• Compensation is the process of using the results from an Additive Manufacturing Process
Simulation analysis to create a pre-deformed additive manufacturing part that it suitable for
printing.

o You cannot automatically generate compensated/deformed geometry from computed
deformations for models created with convergent geometry.

o When you compensate a patterned part, the software only compensates the first occurrence
of the part.

Caveats
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Motion

Caveats
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Caveats

The following issues currently exist in Motion.

Model definition files

You cannot use the Simcenter 3D Motion Definition File Toolkit to solve models with higher-pair
constraints or flexible bodies based on an ANSYS file.

Road visualization

If you enable visualization for an RSM2000 file and use a small grid density (such as 10 mm), you might
experience performance issues.

Submechanisms

The following functionality does not support submechanisms:

• RecurDyn solver

• Adams/Solver

• JT export

• PLMXML import/export

• Capture arrangements linked from a submechanism

• Create sequence to master parts and create explosion to master parts linked from a submechanism

• Update design position

• Change reference set

• Import from subassembly

• Teamcenter 4GD

• Partial loading

• Referencing a flexible link or spline beam from a submechanism

Caveats
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Teamcenter Integration and Motion

You cannot upload external files to Teamcenter when you import a motion part that was created in a
previous release. To work around this issue, open a previous version motion part in the current version
of Simcenter 3D and save it. Then, import the saved motion part to Simcenter 3D.

Virtual.Lab-to-Motion translation

Virtual.Lab models where a parent model references parameters (expressions) or solver expressions
(math functions) in a submechanism do not translate properly.

User-Defined Force attributes with spaces in the name do not translate properly.

Solver expressions (math functions) that reference Amesim watch variables using eval_control_node
are not translated correctly.

(PR9320383) Translating LMS Virtual.Lab Motion models that are located in a directory with non-
standard characters (for example, é) does not work properly. To work around this issue, move the model
to a directory that does not have special characters before opening it in Simcenter 3D Motion.

Math functions do not migrate properly. Therefore, the results produced by the migrated math functions
might be different than the results generated in Virtual.Lab because the dimensionality of the data
source (math function, profile, expression, or other Motion elements) is ignored in Simcenter 3D
Motion.

Simcenter 3D Motion-TWR

Some session data is not saved to Motion after closing Simcenter 3D Motion-TWR. For example, plots
may not be recovered and out-of-date statuses on test rigs may not be saved.

All coordinate systems that are to be used with Simcenter 3D Motion-TWR must reside in the Simulation
file, not in part files.

Submechanisms are not supported.

A Work in Progress dialog box may appear during the Simcenter 3D Motion-TWR process and remain for
the duration of the session. To work around this issue, close Simcenter 3D Motion-TWR and immediately
reopen it in the current session of Motion.

Simcenter 3D Motion-TWR may take a long time to open when using a node-locked license. To work
around this issue, use a value-based license.

Caveats
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Using slave drives with restart analyses may cause issues when repeating the process multiple times in
the same session.

The Adaptive Modeling feature is not working correctly.

Simcenter 3D Motion Real-Time Export

When creating a Simcenter 3D mechatronics element for export to a real-time platform, the gain and
bias values are always set to one and zero, respectively. To work around this issue, use other control
elements to scale values going in to the mechatronics. This restriction is only for real-time solutions. The
gain and bias values work as expected in standard solutions.

General

(PR9182872, PR9180895) The mass calculation functionality is providing different inertia directions on
body occurrences. This is a numerical tolerance issue and only happens in simple symmetric models,
such as a cube.

(PR8380201, PR9170607) Marker position is reported as marker's initial position transformed with rigid
body transformation. The flex body transformation is not considered.

Caveats
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Documentation notes

Solvers

The NX Motion solver supports the same functionality as the Simcenter 3D Motion Solver, with the
exception of the following:

• Tires and roads

• Co-simulation

• Flexible links that use the finite element method

• Model definition files

• Adams and RecurDyn results in the Simcenter Results Viewer

When you see a reference to the Simcenter 3D Motion Solver in the documentation, the same reference
applies to the NX Motion Solver. With the exceptions listed above, if it is supported in the Simcenter 3D
Motion Solver, it is supported in the NX Motion Solver. Likewise, if it is not supported in the Simcenter
3D Motion Solver, it is not supported in the NX Motion solver.

The assembly algorithm in the Simcenter 3D Motion Solver is different from the assembly algorithm in
Virtual.Lab. This difference could result in different positioning of the components when you send them
to the solver. Therefore, for models that are defined in a non-assembled state and which have drivers,
the results of assembly analysis may be different. To resolve this difference, you should introduce
enough initial conditions to guide the assembly analysis to the desired assembled solution. You can also
modify the model to define it in an assembled configuration.

Models that are defined with redundant constraints and friction elements with non-zero stiction
coefficients may cause over-constrained systems that the software may not be able to solve.

Documentation notes
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8. Validation
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Model Based Systems Engineering
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Product Notes

Teamcenter compatibility

When you integrate NX with Teamcenter 11.6, the Associate to NX and Disassociate from NX buttons
are not available in the Active Workspace web client in NX.

Product Notes
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Check-Mate and Requirements Validation

Product Notes
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Caveats

Validation rules

Validation rules do not recognize unset part attributes.

Using NX Issue Management

To use NX Issue Management, Teamcenter Issue Manager must be deployed from the server by the
Teamcenter Environment Manager. If NX cannot connect to Teamcenter Issue Manager, you will see a
message. For more information, see the Teamcenter Environment Manager help.

Using Teamcenter for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when
Teamcenter Issue Manager is deployed by Teamcenter Environment Manager on the server side.

Caveats
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Caveats
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9. Tooling Design
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Tooling Design documentation notes

Hands-on learning aids in the online help

The online help now includes a limited number of hands-on procedures with part files to download,
which let you work through detailed instructions on your own. These hands-on procedures are a good
learning tool to try out new functionality and complex workflows. The procedure topics are titled
Hands-on: <Procedure name>.

Tooling Design documentation notes
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Press Die Checker

Tooling Design documentation notes
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Product Notes

Platform support

Press Die Checker is currently supported only on the Windows platform.

Product Notes
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Caveats

Modifying collision checks

To modify the collision checks, you must install the Manufacturing package from the installation menu
of NX. The issue is fixed in the next NX release.

Caveats
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OmniCAD

Caveats
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Product Notes

OmniCAD

Starting with NX12.0.1, you are no longer required to run the InstallSentinel.bat file to run commands
in the OmniCAD for NX application.

Product Notes
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Mold Wizard

Product Notes
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Optimized settings for MW Part Family Library

There are several recommended settings to improve the performance of your session of Mold Wizard.
These settings are located within the Customer Defaults, Visualization Preferences, and Selection
Preferences dialog boxes. You can double-click MW_Setting.vb located in the MW Part Family Library
to automatically set the following:

Customer Defaults

• Disable missing interpart warnings.
• Disable material to avoid material part attribute conflicts.
• Set the pocket color to match the tool body color when you create new geometry.
• Disable creating part and model view preview images at any time during the design.
• Disable Update Reading Direction after View Rotate for PMI.
• Enable double-clicking a feature to edit its parameters.
• Enable Apply Changes to Owning Part when editing an object's display parameters.
• Treat a Degree 1 spline as a polyline.

Visualization Preferences

• Enable session translucency.
• Disable emphasis precedence for the work part.

Selection Preferences

• Disable Highlight Selection on Rollover.

Optimized settings for MW Part Family Library
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Progressive Die Wizard

Optimized settings for MW Part Family Library
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Optimized settings for PDW Part Family Library

There are several recommended settings to improve the performance of your session of Progressive Die
Wizard. These settings are located within the Customer Defaults, Visualization Preferences, and
Selection Preferences dialog boxes. You can double-click PDW_Setting.vb located in the PDW Part
Family Library to automatically set the following:

Customer Defaults

• Disable missing interpart warnings.
• Disable material to avoid material part attribute conflicts.
• Set the pocket color to match the tool body color when you create new geometry.
• Disable creating part and model view preview images at any time during the design.
• Disable Update Reading Direction after View Rotate for PMI.
• Enable double-clicking a feature to edit its parameters.
• Enable Apply Changes to Owning Part when editing an object's display parameters.
• Treat a Degree 1 spline as a polyline.

Visualization Preferences

• Enable session translucency.
• Disable emphasis precedence for the work part.

Selection Preferences

• Disable Highlight Selection on Rollover.

Optimized settings for PDW Part Family Library
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10. Data translation
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Product Notes

Updates in the default tessUG.config JT configuration file

The doSectionViews configuration option which is used to process non-lightweight PMI section views
(also known as heavyweight section views) is removed from the default tessUG.config file shipped with
NX11. This option is now renamed as LegacyHeavyweightSectionViews. If your existing NX part or
assembly contains section views created using PMI tab→Section View command in Pre-NX11 versions
and you want to translate these section views to a JT file, you need to add
LegacyHeavyweightSectionViews option in your tessUG.config configuration file and set it to
true.

CATIA V5 translator product notes

You can now import CATIA V5-6R2018 SP3 files to NX.

ACIS translator product notes

You can now read and write ACIS version up to R28.

DXF/DWG translator product notes

You can now read and write AutoCAD DXF/DWG version up to 2018.

NX to JT translator product notes

NX to JT translator now supports the IRAY texture material translation to the JT file.

NX ProE translator product notes

You can now import Creo5.0 files to NX.

Product Notes
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Caveats

Internationalization caveat

File import or export by the following translators may not work if you set the NX temporary directory
UGII_TMP_DIR to a folder containing non-locale characters.

• DXF/DWG

• IGES

• STEP

• 2D Exchange (export only)

NX to JT translator caveats

NX to JT translator caveat for the Windows operating system

If you are translating pre-NX11 parts with material, texture, and light applied on it and you want to
get the texture or light information into the JT file, We recommend you to invoke NX in Author2
(non-IRAY+) rendering mode and then translate the parts to a JT file. This recommendation is
applicable for JT creation from interactive NX session as well as command line application ugtopv.
Contact GTAC to get more information on how to invoke NX in Author2 (non-IRAY+) rendering
mode.

Note:
If you invoke NX in Author2 (non-IRAY+) rendering mode then these options will be available
in the JT Configuration and the Export JT dialog boxes.

NX to JT - IRAY texture and material caveats

In some situations, you may find differences between the quality of the texture displayed in NX and
that displayed in JT, when you view it in the Teamcenter Visualization.

DXF/DWG translator caveats

File→Export→DXF/DWG does not work in NX manager.

DXF/DWG — Dimension export caveats

Caveats
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These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG
Export Wizard dialog box.

• Dimensions associated with external references are exported as non-associative dimensions to
the DXF/DWG file.

• NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block
reference.

• The dimension associated between NX sheet object and View port object may be translated as
overridden text of AutoCAD dimension.

• Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.

• Chamfer and Thickness dimensions are exported as block reference to the DXF/DWG file.

• Angular dimensions created with vector option are exported as block reference to the
DXF/DWG file.

• Dimension with fits tolerance having fit tolerance style other than Fit Symbol is exported as
block reference in AutoCAD.

• Dimension text location may not match with NX for the dimensions created with oriented text.

• Dimension line breaks and foreshortening symbols are not supported when dimension is
exported as group or block.

• If a dimension text is on the extended dimension line, the exported dimension has to be
updated to view any foreshortening symbols on it.

DXF/DWG — MText import caveats

You cannot import:

• MText paragraph tabs to NX.

• Euro symbol (created using %%128 in MText) to NX.

DXF/DWG — Architecture data import caveats

• You can not import:

o View dependent data

Caveats
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o Texture data

o Corner windows

o Wall cleanups

o Body modifiers on staircase

• Associativity defined between the architecture objects is not maintained in NX. For example,
door on wall will not move along if wall is moved.

DXF/DWG — Solids import caveats

You cannot import:

• Material, color, and transparency applied on solids in the DXF/DWG file.

• Solids data at location outside the NX supported bounding box.

DXF/DWG translator- Image translation Caveats

• When you import DXF/DWG model data to NX drawing view, the translator does not support
image translation.

• When you import DXF/DWG file that contains image rotated by angle which is not in a multiple
of 90, the image is imported with zero degree rotation.

Note:
In NX, the images are rotated in steps of 90 degrees only.

• When you import DXF/DWG file with images having other than .jpeg, .tiff, and .png formats to
NX, the translator does not support importing of such images.

• Images are not imported if exported as CGM.

• Image translation is not supported if the DXF/DWG file is imported to workpart.

DXF/DWG translator- 3D Workflow caveats

When you export View Breaks using 3D workflow, the translator does not support an export of the
following:

• NX Object clipping and view break symbols.

Caveats
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• Geometry clipped inside a view boundary.

• A section line arrow in Break view.

Dimension export using 3D workflow

• When a dimension is exported as a block reference, the foreshortening symbol is not
supported.

• 3D workflow does not support the inclusion of before/after appended text in the export of the
inspection dimension. It always includes all the appended text in the frame.

• The translator does not support a tolerance separator in the output DXF/DWG file.

Text export using 3D workflow

• When you export text as lines using 3D workflow, the translator ignores the text symbol aspect
ratio.

DXF/DWG translator- Associative dims to polyline and block caveats

You cannot import dimension as real associative in following scenarios:

• Blocks are imported as custom symbols or as a part and if dimensions are associated with block
reference in the DXF/DWG file.

• Dimensions are associated to 2D and 3D polyline.

• Dimensions that have following Object snap points:

o Tangent

o Perpendicular

o Nearest

o Apparent Intersection

o Parallel

o Intersection

• Dimensions are associated to arc segment of the polyline.

Caveats
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DXF/DWG translator- Support for drafting objects caveats

You can not export:

• Drawings created in the Layout application using the 2D option.

• Custom symbols used in a PMI table.

• Section views.

DXF/DWG Support for Hole table

If the multiple sections of the hole table are created on different drawing sheets, the continuation
text will be lost.

2D Exchange caveats

• File→Export→2D Exchange does not work in NX manager.

• Object attributes with title longer than 50 characters or string value longer than 132 characters are
not exported to 2D parts.

2D Exchange – Dimension export caveats

These caveats are applicable for both, when you export a file using the NX Part file option in the 2D
Exchange Options dialog box or when you export a file using the 2D option in the AutoCAD
DXF/DWG Export Wizard dialog box.

Following dimensions are exported with the Override Dimension Text:

• Feature Parameter Dimensions

• True Length Dimensions

• Dimensions in scaled view and output set to Modeling (applies only when you export a file
using the NX Part file option in the 2D Exchange Options dialog box)

• Dimensions associated to:

o Drafting Intersection point

o Offset center point

Caveats
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o Section line (in scaled view)

• The dimensions where associated object type changes in the flattened part. For example, circle
projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or
DWG file.

• Linear and Radial callouts

• Retained dimensions

• Component level dimensions and PMI dimensions

• Inherited ordinate PMI dimensions

• Dual dimension in scaled views and output set to Modeling.

• Dimension with hole and shaft tolerance in scaled views and output set to Modeling.

• Dimensions associated with:

o Blanked objects

o 3D and Symmetric centerlines

o Faces

o Two object intersection (applies to ordinate dimension only)

o Target Points

• Dimension created in plane other than view plane.

• PMI Partial Bolt Circle centerline.

2D Exchange translator- Image translation caveats

• 2D Exchange Translator does not translate image, if image is not projected on 2D. This happens
when image is in XY plane and trimetric view is exported.

• 2D Exchange Translator supports translation of images only if input is being exported to Part
File and not to IGES).

Caveats
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2D Exchange translator- Dimension export caveats

• When Dimension and a Leader are associated with the symmetrical centerline, the translator
exports them as a grouped geometry.

• When a radial dimension is associated with a break view geometry, the translator exports it as
a group geometry.

• When a perpendicular and angular dimension is associated with a break view section line,
translator exports them as a group geometry.

2D Exchange translator - Foreshortening Symbol export caveats

A translator does not support export of foreshortening symbol when dimension is exported as a
group in a 2D part.

2D Exchange translator – Leader caveats

A leader with an extension line is converted as a grouped geometry when it is associated with a
spline in a 2D part.

2D Exchange translator – Weld symbol caveats

When you export a weld symbol containing arcs, the translator exports it as a grouped geometry.

2D Exchange translator – Support for drafting objects caveats

You can not export:

• Drawings created in the Layout application

• Custom symbols used in a PMI table.

• Section view while exporting Model views.

2D Exchange Support for Hole table

If the multiple sections of the hole table are created on different drawing sheets, the continuation
text will be lost.

DXF/DWG and 2D Exchange - PSM body support project caveats

• If you export convergent bodies as polyline mesh, it exports only edges.

Caveats
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• Colors are not honored when you import 3D faces as convergent bodies or JT facets.

• Colors applied to face of convergent body is not honored on export.

• You cannot export model views with convergent bodies with 2D Exchange (or using 2D option on
DXF/DWG export dialog box).

STEP translator caveats

• When you export or save NX data to a .stpx file, STEP translator does not export nested external
references.

• When you export NX data containing PMI lightweight section views to STEP242:

o Selective object sectioning is not supported.

o Section plane display properties are not supported.

o Section view cross-hatch is not supported.

CATIA V5 translator caveats

• The translator exports NX files to CATIAV5 R14 files.

• You cannot import CATIA V5 R7 and earlier version of files.

• You cannot translate standard and user defined attributes.

• Color is supported on a per face basis.

• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness”
values.

• You cannot export NX parts with file name containing international characters.

• The CATIAV5 translator does not keep a log of failed export of password protected data during
translation.

• When you import data using the options Retain Part Substructure=ON and Include Coordinate
Systems=OFF, empty Axis System and Datum Plane feature groups may result. As a work around,
you can set the option Include Coordinate Systems=ON to produce properly designated Axis
Systems and Datum Planes.

Caveats
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Note that this may result in additional reference geometry, such as planes and axis lines, being
translated.

• When you import a CATIAV5 file in NX using File→Open method, NX does not automatically save
the output file on the disk. You can decide whether to save it or not.

• Before re-importing a CATProduct with different content (potentially due to option choices), it is
best to manually delete previous output files in case the IDs in the node or component part
filenames shift.

• During import, the translator will look for component files at and below any directories specified
through Assembly Search Directories.

• The translator looks for the default settings file in the following sequence:

1. Settings file specified using the d= option if you launch the translator from command line
prompt.

2. Settings file specified using the NX_CATIAV5_DEF environment variable.

3. Settings file specified using customer defaults.

4. Searches for the settings file in the directory specified by the environment variable
UGII_CATIAV5_DIR. If this is not defined on your system, you can set it to %UGII_BASE_DIR%
\catiav5 on Windows or $UGII_BASE_DIR/catiav5 on Linux.

Caveat for all translators

The password protected parts or assembly components are not exported to other file formats.

Caveats
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11. Mechatronics Concept Designer
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Product Notes

PLCOpen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format
PLCOpen XML. PLCOpen XML can be imported into STEP 7 5.5 SP 2 Hotfix 4 and above. If you need to
update your current STEP 7 installation you can find information about the latest service packs and
hotfixes at the following:

English: https://support.industry.siemens.com/cs/products?
dtp=Download&mfn=ps&pnid=14342&lc=en-WW

Product Notes
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12. Automation Designer
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Requirements for running Automation Designer NX 1847

• Software platform

o NX 1847

o Teamcenter 11.6

Automation Designer must be set up as a client/server application with a preconfigured
Teamcenter installation

• TIA Portal

A valid TIA Portal license

o STEP7 Professional Combo V14 SP1, V15 or V15.1

o STEP7 Safety Advanced Combo V14 SP1, V15 or V15.1

o Drive Support: SINAMICS Startdrive V14 SP1, V15 or V15.1

• EPLAN

A valid EPLAN runtime license and EPLAN runs on the same machine as Automation Designer.

The standard EPLAN Electric P8 installation provides EPLAN project templates.

Automation Designer supports only zw9 files.

o EPLAN Electric P8® v2.6 (64 bit only)

o EPLAN Electric P8® v2.7 (64 bit only)

o EPLAN runtime license 0193

• eCl@ss

Using the eCl@ss standard requires a valid license. The Terms of Use for the eCl@ss standard states:
"This content contains eCl@ss. The use of the eCl@ss standard requires a license. Please register
and order in the DownloadPortal (www.eclassdownload.com)."

Requirements for running Automation Designer NX 1847
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Automation Designer supports eCl@ss ADVANCED Version 8 and newer.

• Operating system requirements

Automation Designer supports the versions of Windows as supported by NX.

Requirements for running Automation Designer NX 1847
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Caveats

Installation

4th
Generation
Design base
license

Automation Designer relies on 4th Generation Design features. Each NX client uses a
4th Generation Design base license that must be present before your start the
application. If there are less licenses for 4th Generation Design than NX clients,
Automation Designer might not be supported and does not work.

For all NX clients that do not require 4th Generation Design, set the environment
variable UGII_DISABLE_4GD=True.

General

Inspection of
snapshot

The functionality to inspect into a snapshot is limited and experimental. It is only
available when you set the environment variable:
AD_ENABLE_INSPECT_SNAPSHOT=1.

You can inspect a snapshot while the same project is closed, and no other snapshot of
this project is inspected at the same time.

Copy If you copy a template usage with Engineering Objects on a page, it may be that the
Engineering Objects in the pasted template usage are shown in a flat structure instead
of the original structure in an aspect navigator.

Copy to Object does not work for a Distributed Object in Automation Navigator.

Navigations
and
expressions

• Copying a navigation or expression to another Engineering Object also copies
unrelated navigations or expressions to the other object.

• Deleting an Engineering Object with expressions or navigations deletes also
dependent expressions of other Engineering Objects.

• The sum navigation does not work for user created properties of a user created
category.

• If you create a navigation to calculate the object name of an Engineering Object
and the navigation use the aspect name as an input, but there is no aspect name
set (is empty), then Automation Designer crashes with an unrecoverable error.

Caveats
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• A connection that was set by a navigation is not removed, when the
corresponding navigation is removed.

If the conditions for the navigation change, the connection also remains.

• If you copy tags or objects with tags in a project, Automation Designer does not
update the navigation targets on the tag. The navigation continuously points to
its original target.

• If the property Object Name is set on a Type by Object Dynamization, creating a
new revision of this Type will have the dynamization present, but the property
does not reference it anymore.

• The user interaction workflow is improved and enhanced so that you are able to
apply NX expressions to those expressions that are not evaluated yet due to a
later mapping in time. The changes are listed and covered below:

o A new drop down list is implemented where you can select the Attribute
data type.

o For NX attributes that already exist, use always the names of the attributes
as exported by the attribute export of the NX dialog as the manual input of
Attribute Category and Title fields.

o If you use the Determine by expression option in the Reference Property
dialog box, Automation Designer creates an object navigation if it does not
exist already. You can use this to access objects for which the Expressions
dialog box was launched. The default name of this object navigation is
ObjectNavigation.

Note:
The ObjectNavigation name is not translated to any other languages.

o The value is successfully extracted only if all parameters match as for
example the Attribute Title, Category and Type.

Performance Queries that contain one of the following features are executed slowly:

• Clauses for ports.

• Clauses for parent properties.

• Logical combinations of clauses.

Caveats
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Collaboration

Baseline
configuratio
n and
mappings

If a 4G baseline is used as a configuration for the data of another discipline, for
example mechanical design or layout, object mappings to the components that are
configured with the baseline are not saved.

Multiple
Automation
Designer
projects
using the
same
mechanical
design

When multiple Automation Designer projects use the same mechanical design, only
one Engineering Object can be mapped to the same mechanical component at a time.
In the other Automation Designer projects, object mapping is disabled for the
component.

You must first unmap the component in the project where the mapping already exists,
before you can map to a particular mechanical component.

Performance When you map a large number of mechanical objects to templates, Automation
Designer stops responding for a while before it completes the operation.

Visual
Reporting

After creating a visual report, the projects needs to be saved before switching to
another aspect navigator.

If the application user data of a visual report contains data of external objects, as for
example data of mechanical components, Automation Designer lose the attachment of
the application user data. You must reattach the data before you can start another run
of the visual reporting.

4G_Populate
on imprecise
assemblies

To realize an imprecise assembly into 4th Generation Design, you must set the
RLZ_enable_imprecise_source_item_assembly=true preference in Teamcenter.

Notes in
Cabinet
Design

If you place notes in a cabinet design, you must use the default option of placing the
coordinate system.

Products

eCl@ss
Import

There is no update functionality for eCl@ss Import. Even if the product already exist,
system creates a new product.

Schematic diagrams

• If you use Undo to junctions, a following Redo does not work.

Caveats
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• Reports using query features as they are listed in General→Performance are slow.

• Autoconnection is not supported, when fragments are inserted via Ports Manager.

• Terminals, targets and port arrangement are displayed incorrectly in Terminal diagram reports.

• While placing symbols from an aspect navigator, you must use pick and place. Drag and drop is not
supported.

• Before you can place a symbol from the symbol library via drag and drop on a page, you must click
on that page.

• Connections might overlap or get bent

o When you move symbols with a Disconnect on move command.

o While you use the Multi-connect command with bends.

o While fragments are moved quickly when being inserted to a page.

• Printing a PDF of the diagrams creates one document per page.

• Multi-level Reference Designations are not shortened as the Reference Designation Set is.

• Interruption points support manual editing of names only.

• Second connection points for a port cannot be connected.

• Ports on schematic pages do not auto-connect on pages.

Software Generation

Importing
Program
blocks

If you use TIA Portal V15SP1, the error message Program Block is not compiled in TIA
Portal can be shown while importing software blocks. You must update to TIA Portal to
version 15.1.0.1.

Creating IDB An IDB which was created in an aspect navigator does not connect automatically to its
FB. If updates are required, you must connect manually the IDB to the FB.

Caveats
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13. Programming Tools
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Open C
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New Open C routines

The following routines are new for this release:

UF_ask_load_state_for_part_file
UF_ask_load_state_of_part
UF_ASSEM_add_part_to_assembly2
UF_ASSEM_reposition_instance2
UF_CLONE_set_export_external_files
UF_CURVE_create_precise_outline
UF_CURVE_create_precise_outline_curves
UF_PART_find_tag_of_display_name
UF_PART_inherit_status_of_template

New Open C routines
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Obsoleted Open C routines

The following routines are now obsolete and will be deleted in the next major release of NX:

UF_ROUTE_add_terminal_ports
UF_ROUTE_add_virtual_ports
UF_ROUTE_are_ports_connectable
UF_ROUTE_ask_app_view_def_stock
UF_ROUTE_ask_app_view_ext_plib
UF_ROUTE_ask_app_view_plib_view
UF_ROUTE_ask_connection_ports
UF_ROUTE_ask_loaded_bend_tables
UF_ROUTE_ask_multiport_strings
UF_ROUTE_ask_multiport_tags
UF_ROUTE_ask_multiport_termname
UF_ROUTE_ask_object_port
UF_ROUTE_ask_part_occ_ports
UF_ROUTE_ask_port_align_flag
UF_ROUTE_ask_port_align_vector
UF_ROUTE_ask_port_back_extension
UF_ROUTE_ask_port_back_extension_obj
UF_ROUTE_ask_port_charx
UF_ROUTE_ask_port_clock_increment
UF_ROUTE_ask_port_connected_port
UF_ROUTE_ask_port_connection
UF_ROUTE_ask_port_conn_port
UF_ROUTE_ask_port_cut_back_length
UF_ROUTE_ask_port_engaged_pos
UF_ROUTE_ask_port_engagement
UF_ROUTE_ask_port_engage_obj
UF_ROUTE_ask_port_extension
UF_ROUTE_ask_port_extension_obj
UF_ROUTE_ask_port_lock_info
UF_ROUTE_ask_port_multiport
UF_ROUTE_ask_port_occ_of_port
UF_ROUTE_ask_port_on_segment
UF_ROUTE_ask_port_part_occ
UF_ROUTE_ask_port_position
UF_ROUTE_ask_port_rotate_flag
UF_ROUTE_ask_port_rotate_vector
UF_ROUTE_ask_port_segment
UF_ROUTE_ask_port_stock

Obsoleted Open C routines
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UF_ROUTE_ask_port_terminal_ports
UF_ROUTE_ask_rcp_at_term_port
UF_ROUTE_ask_terminal_multiport
UF_ROUTE_ask_terminal_port_uid
UF_ROUTE_bend_report_ask_number_of_bends
UF_ROUTE_bend_report_free_mil98_report
UF_ROUTE_bend_report_free_segment_info
UF_ROUTE_bend_report_free_xyz_report
UF_ROUTE_bend_report_free_ybc_report
UF_ROUTE_bend_report_generate_mil98_report
UF_ROUTE_bend_report_generate_xyz_report
UF_ROUTE_bend_report_generate_ybc_report
UF_ROUTE_bend_report_get_segment_info
UF_ROUTE_bend_report_reverse_direction
UF_ROUTE_connect_port
UF_ROUTE_create_bend_by_table
UF_ROUTE_create_multiport_from_position
UF_ROUTE_create_port_at_segend
UF_ROUTE_create_port_lock
UF_ROUTE_delete_port_lock
UF_ROUTE_disconnect_port
UF_ROUTE_find_port_charx
UF_ROUTE_find_terminal_port
UF_ROUTE_is_port_fixture_port
UF_ROUTE_is_port_multi
UF_ROUTE_is_port_terminal
UF_ROUTE_remove_terminal_ports
UF_ROUTE_remove_virtual_ports
UF_ROUTE_set_port_back_extension
UF_ROUTE_set_port_back_extension_obj
UF_ROUTE_set_port_clock_increment
UF_ROUTE_set_port_engagement
UF_ROUTE_set_port_engagement_obj
UF_ROUTE_set_port_extension
UF_ROUTE_set_port_extension_obj
UF_ROUTE_set_port_id
UF_ROUTE_set_port_lock_rotation_flag
UF_ROUTE_set_port_rot_by_point
UF_SF_create_contact_mesh
UF_SF_create_edge_face_conn
UF_SF_create_ugs_2d_mesh
UF_SF_create_ugs_2d_mesh_with_hdpts
UF_SF_create_ugs_2d_mesh_wt_abstraction_control

Obsoleted Open C routines
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UF_SF_create_ugs_tet_mesh
UF_SF_create_ugs_tet_mesh_wt_abstraction_control
UF_SF_mesh_2d_loops
UF_UI_route_invoke_callback

Obsoleted Open C routines
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Deleted Open C routines

The following routines are deleted for this release:

UF_ROUTE_ask_port_conn_port
UF_ROUTE_is_port_terminal
UF_ROUTE_is_port_multi
UF_ROUTE_add_terminal_ports
UF_ROUTE_ask_connection_ports
UF_ROUTE_ask_port_engage_obj
UF_ROUTE_ask_port_engaged_pos
UF_ROUTE_ask_port_engagement
UF_ROUTE_ask_terminal_multiport(tag_t terminal)
UF_ROUTE_remove_terminal_ports(tag_t multi)
UF_ROUTE_remove_virtual_ports(tag_t multi)
UF_ROUTE_find_terminal_port
UF_ROUTE_bend_report_get_segment_info
UF_ROUTE_bend_report_reverse_direction
UF_ROUTE_bend_report_ask_number_of_bends
UF_ROUTE_bend_report_free_segment_info
UF_ROUTE_bend_report_generate_xyz_report
UF_ROUTE_bend_report_free_xyz_report
UF_ROUTE_bend_report_generate_ybc_report
UF_ROUTE_bend_report_free_ybc_report
UF_ROUTE_bend_report_generate_mil98_report
UF_ROUTE_bend_report_free_mil98_report

Deleted Open C routines
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NX Open

Deleted Open C routines
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NX Open differences between releases

The NX Open differences between releases and deprecated items replacements are now published in
the Documentation Center.

In the Documentation Center, for your release, click What's Changed in NX Configuration and NX
Open. From there, click NXOpen APIs to open the NXOpen APIs What's Changed Reports webpage.

You can select the Changes That May Require Code Changes tab to view the changes that have
occurred for the release and any that might require changes to your existing code. The What's New tab
provides new items for the release.

You can compare your release to another one to see the amount of change that has occurred between
the two releases. In the Comparing NX <your release> and: listing, select the release you want for
comparison, and click Compare. You can get comparisons for up to two years of releases.

NX Open differences between releases
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Release upgrades

A primary goal of NX Open is to maintain your automation investments. This is done by adopting
policies which minimize the amount of required code changes by you to migrate your applications to
new releases of NX. The following contains a description of these policies and how they impact your
ability to support the users of your applications, and the steps you should take to successfully move your
application to new releases of NX.

NX Open API change policy

NX maintains the following three primary policies to protect your investments:

• API stability

Stability ensures that the API that has been released will continue to work. This means that the API
is still present in future releases and the behavior of the API doesn't change. API changes should be
designed to minimize any changes to your source code. For example, if the capabilities of a method
are expanded which requires new parameters, then NX may maintain and optionally deprecate the
original method and add a new method that includes the new capabilities. By doing this, existing
applications do not require code changes unless they want to take advantage of the new
capabilities.

• Binary compatibility

Compatibility means that applications that are built against a specified release continue to work
with subsequent releases. This requires not only that API stability is maintained but also is binary
compatible. For example, re-ordering the values of enum members so that API stability is
maintained. In this case, the values have changed so existing automation programs will be using
the wrong values. In other cases, deleting a method or modifying the inheritance hierarchy of a
class will likely cause run-time errors for existing programs.

The other aspect of binary compatibility is the compiler. When the compiler NX uses changes, this
may break binary compatibility of automation programs. While some language bindings are more
tolerant of being backwards compatible, such as Java, others are not as tolerant, such as C++.

NX libraries will be forward compatible for all releases in a release family. If you compile and link
your application with the libraries shipped with a functional release of NX, such as NX 1847, then
your application should continue to run with all future monthly releases in that release family (NX
1847). This compatibility means you do not need to recompile, relink, and reship your applications
to customers running various monthly releases of NX. Note that NX is not backwards compatible,
which means you can't compile and link an application in NX 1847 and expect it to work in NX 12.

Release upgrades
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NX will only change the compiler used (breaking binary compatibility) in a functional release and
will not change it more than once a year. During the functional release, the compiler may change
and APIs may be retired per the deprecation policy for deletion.

• Deprecation policy

If an API change requires you to make source code changes, you are given notice one year in
advance, if possible. For example, if a method is going to be replaced by a new method, the
original method is marked as deprecated in NX 1847, which is the release family. The original
method is maintained through the current release family and through the next release family also,
after which the API may be retired and removed.

The what's changed reports in the Documentation Center and, if possible, compile time warnings
are used to warn you of changes made in the current release and changes coming in the next
release. The deprecated items topic in the Documentation Center provides a list of the deprecated
methods and their replacement methods.

For more information about the Documentation Center, see NX Open differences between
releases.

Note:
NX development makes every effort to follow the above policies. However, there may be instances
when the policies must be violated due to the type of changes required. When this type of change
is made, it is published on the Changes That May Require Code Changes tab in the
Documentation Center. This includes information on the change that happened and suggests
changes that could be made to the code.
NX maintains and publishes stability metrics that show that for at least the last 10 years the
stability of the NX Open APIs is above 96% for any given release, while the average is above 99%.

Exploring changes to the NX Open API between releases

NX Open changes are published in the Documentation Center. In the NXOpen APIs section for your
release, you can view API changes in the NXOpen APIs What's Changed Reports.

By default, this webpage contains the reports of the current release and the last functional release. In
addition, you can select a release to compare with your release to get a comparison between the two
releases. You can get comparisons for up to two years of releases.

Each page presented provides a point-to-point comparison of the APIs. The What's New tab on the page
presents the new API items added between the two selected releases. The Changes That May Require
Code Changes tab provides information that shows the changes that violate API stability and (or) binary
compatibility, in accordance with the rules specified in the above policies.

Release upgrades
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For example, removing API items violates our API stability and binary compatibility policy unless the
compiler changes. For each entry, we provide remediation suggestions, if needed, and possibly the
reason for the change. An example of a change for which the only remedy is to recompile, is if a class
has a new base class inserted into it's hierarchy. In this case, you don't need to change your code, but
you do have to recompile your automation code that uses the API. This is contrasted by changes to a
method signature to add an additional parameter. In this case, there will be a description of what the
new parameter's purpose is and how to use it.

Also, the Changes That May Require Code Changes tab lists all of the deprecated APIs, their
replacement APIs, and the earliest that each API could be retired. APIs that are retired are listed on the
tab, along with when the API was removed and their replacement.

Open C API changes are listed in the NX release notes, in the New Open C routines, Obsoleted Open C
routines, and Deleted Open C routines topics.

Function declarations that are newly retired (obsolete/deprecated) are moved to the uf_retiring.h file,
which contains a complete list of Open C functions that could be deleted in the next NX release.

Release upgrade process for a functional release

For each functional release of NX, you should perform the following steps to migrate your application to
the release:

1. Review the Changes That May Require Code Changes tab for the release you are going from and
upgrading to. This helps you to understand what changes are being made in the release and what
changes are planned for the next release.

2. For any methods or properties that have been deleted and for those which you have not already
replaced in your code, implement the replacement code.

3. Recompile your entire source base using the current compile time files and settings for the given
release.

4. For any methods or properties that produce deprecation warnings, decide if you are going to
replace this code now or in the next release.  Implement the replacement code for any deprecated
methods you want to replace now and recompile.

5. Link your application with the appropriate NX Open libraries.

6. Perform a full suite of application testing in a stable NX environment.

7. Distribute your applications to your user base.

Release upgrades
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Release upgrade process for a monthly release

For each monthly release of NX, you should perform the following steps to migrate your application to
the release:

1. Review any changes for the monthly release in the Documentation Center.

2. Any API changes that may require rework or a recompile of your code will only be made if
absolutely necessary. In this case, you will have to rework or recompile the affected applications,
then test and redistribute. These changes are provided in the Documentation Center.

Release upgrades
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Product Notes

Compilers and environments to use for NX Open programs

The following table specifies the compiler (or installation for Python) to use for the applicable platform.
These are the only ones certified for use with NX Open:

Windows Linux

C/C++ Visual Studio 2017 Build
19.10.25017

gcc 4.8.2

.NET .NET 4.6.2 Framework N/A

Java (64–bit) JDK 1.8.0_45 JDK 1.8.0_45

Python (64–bit) Python 3.6.1 Python 3.6.1

Running Java and .NET programs

To run programs created in NX Open that require Java or .NET, the following is required:

Windows Linux

.NET .NET 4.6.2 Framework N/A

Java (64–bit) JRE 8 JRE 8

Note:
Some standard NX applications, such as translators, require installation of the JRE. For additional
information, see Considerations and caveats.

Recreating projects when installing a new release

When you install a new, major NX release, such as NX 11, all projects created in the previous release
need to be recreated in the new release using the new NX wizard with the corresponding, supported
Studio version. This ensures that all project settings are compatible for use with that NX version.

Linking to libraries for UGOpen APIs

Starting in NX 9, for those programs that call C/C++ UGOpen APIs, you need to link those programs to
libufun and libufun_cae. If you are using CAE APIs, you need to ensure that you link to libufun_cae.

Product Notes
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Starting in NX 10, for those programs that call C/C++ UGOpen APIs, you need to link those programs to
libufun_cam. If you are using CAM APIs, you need to ensure that you link to libufun_cam.

Installing Programming Tools help

On Windows systems, the Programming Tools help is now an optional, selectable feature of the NX Help
Install and not selected by default. To install the Programming Tools help you need to click on the icon
for NX API Manuals from the Custom Setup page of the documentation install. Refer to the NX
Documentation (UGDOC) Installation Instructions for Windows for further details.

Changes to utility names

The .NET signing utility is changed from SignLibrary.exe to SignDotNet.exe. The C++ signing utility is
changed from nxsign.exe to signcpp.exe. These name changes better reflect the actual application of
the utilities.

UF and JA APIs

All of the UF_NXSM functions were removed in NX 10 and there is no one-to-one mapping for those UF's
to the JA APIs. The builder objects contain all of the APIs required for automation. Refer to the
Feature.builder for the following sheet metal APIs:

Feature Feature.builder

Base Contour
Flange

Feature.SheetMetal.Conto
urFlangeBuilder

Base Tab Feature.SheetMetal.TabBu
ilder

Bend Feature.SheetMetal.Bend
Builder

Closed
Corner

Feature.SheetMetal.Close
dCornerBuilder

Flange Feature.SheetMetal.Flang
eBuilder

Flat Solid Feature.SheetMetal.FlatS
olidBuilder

Jog Feature.SheetMetal.JogBu
ilder

Rebend Feature.SheetMetal.Rebe
ndBuilder

Secondary
Contour
Flange

Feature.SheetMetal.Conto
urFlangeBuilder

Product Notes
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Feature Feature.builder

Secondary
Tab

Feature.SheetMetal.TabBu
ilder

Unbend Feature.SheetMetal.Unbe
ndBuilder

UF functions

Starting in NX 11, the following are changes to UF functions:

• UF_KF_ask_string()

In prior releases, this function returned a pointer that did not need to be freed. Now the pointer
returned needs to be freed to prevent a memory leak. The new prototype is:

extern UFUNEXPORT int UF_KF_ask_string
(
   UF_KF_value_p_t  value,/* <I> Knowledge Fusion value */
   char            **string/* <OF> Value. Must be freed. */
);

• UF_KF_ask_name_chain_of_instance()

In prior releases, this function returned a pointer that did not need to be freed. Now the pointer
returned needs to be freed to prevent a memory leak. The new prototype is:

extern UFUNEXPORT int UF_KF_ask_name_chain_of_instance
(
   UF_KF_instance_p_t   instance,/* <I> Knowledge Fusion instance */
   char         **name_chain/* <OF> Name chain of instance. Free 
with UF_free. */
);

Product Notes
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Caveats

Using title and alias values in SetTitle API

When creating or modifying an attribute using the AttributePropertiesBuilder class, the SetTitle API
previously accepted either a title or an alias as a valid value for locating the attribute. Starting in NX 11,
the SetTitle API only accepts a title as a valid value for locating the attribute.

Journals recorded using NX 8 to NX 8.5.2 that created attributes with aliases using the
AttributeProperitesBaseBuilder class auto-journalled the alias as the attribute for SetTitle. These
journals no longer locate the attribute in NX 11 due to the above change. Journals recorded using NX
8.5.3 and later auto-journaled the title as the value for SetTitle and continue to locate the attribute as
expected.

Playing a Python journal

Unlike VB.NET and C#, you must save a Python journal to a file that you create in the Journal Editor
before playing it in NX.

Using a flag with removed option for Clearance Analysis

The ignore mated pairs optional setting is removed from the assembly Clearance Analysis
functionality in NX. Therefore, the corresponding flag UF_CLEAR_EXCLUDE_MATING_PAIRS can no
longer be used. If this flag is passed to the function UF_CLEAR_set_exclude_rules, the error value from
UF_CLEAR_err_bad_exclude_rules is returned.

Mapping part attributes

All of the part attributes in Teamcenter were represented as strings in NX. This caused problems with
NX, therefore some attributes can now be mapped to the same data types defined in Teamcenter. The
topic NX attribute type matches Teamcenter attribute type in Programming Tools describes the APIs and
NX versions where this is applicable. However, the APIs and NX versions have changed. The following
Software Field Bulletin contains the latest data for the applicable APIs and NX versions.

SFB-NX-6866: NX Part Attributes Mapped From Teamcenter

Note:
Always refer to the latest version of the Software Field Bulletin.

Caveats
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Documentation Notes

NX Open Java Reference Guide

The URL for a search result depends on your Java version. If the link for a search result does not work,
manually remove /undefined from the URL. For example, change /open_java_ref/undefined/nxopen/
Part.html to /open_java_ref/nxopen/Part.html.

Internet browsers

If you do not see the latest documentation for the following progamming tools, it may be a cache issue.
Try clearing your cache, or using a different browser.

• Open C Reference Guide

• NX Open C++ Reference Guide

• Open for Java

• NX Open Python

• Open for .NET

In the Open C Reference Guide, if links to the example .c files do not work in IE, the .c file may not have
an associated program to open it. Follow the instructions for your operating system to associate the .c
file to a program, such as Notepad.

Custom features for Block UI Styler

Any custom feature operation, such as create, edit and so on, that includes the Block UI Styler does not
support the redo operation. This is because the Block UI Styler does not support redo.

Batch Processing in GRIP

In the GRIP documentation, File Management→Batch Processing→Compile, Link, or Run section, the
location of the subprograms is modified. The last sentence in the file list parameter is changed to:

If any of the programs that are linked in a batch mode require subprograms that are in other
directories, the full path for the directory containing the subprograms must exist in a text file
named gri.sea, which resides in the current directory (can also reside in the $UGII_UTIL directory).

Documentation Notes
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Keystroke callback for the String block

When you create a dialog box using the Block UI Styler application, for every String block that you add to
the dialog box, NX provides a keystroke callback to process the input typed in the block for each
keystroke.

The syntax of a keystroke callback is as follows:

'Public Function KeystrokeCallback(ByVal string_block As 
NXOpen.BlockStyler.StringBlock, ByVal uncommitted_value As String) As 
Integer
'End Function

‘Input parameters:
“string_block”: Refers to the string block in which text is being typed,
“uncommitted_value”: Contains the uncommitted text being typed in string 
block.'

By default, this callback is commented. To use it, you need to uncomment the callback, and write code
in the callback function to perform the required processing. NX provides this callback in all the
supported programming languages.

You can use this callback to process each input keystroke of the dialog box user. For instance, you can
write code in this callback function to filter or sort the list values per the keystrokes in the String block.

Documentation Notes
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Example:
When you build a dialog box that contains a List block and a String block with the following
keystroke callback, designers can filter the strings populated in the List block per the text entered
in the String block.

'-------------------------------------------------------------------
-----------
    'StringBlock specific callbacks
'-------------------------------------------------------------------
-----------
Public Function KeystrokeCallback(ByVal string_block As 
NXOpen.BlockStyler.StringBlock, ByVal uncommitted_value As String) 
As Integer

            'Filter/sort string list based on uncommitted value*
        Dim filteredStrings() As String = 
getSortedFeatureIDs(uncommitted_value)
            
            'Set filtered list to list box in dialog. 
            list_box0.SetListItems(filteredStrings)
            

End Function
“string_block”: Refers to the string block in which text is being 
typed,
“uncommitted_value”: Contains the uncommitted text being typed in 
string block.'

Documentation Notes
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